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1 Introduction
Introduction
Congratulations and thank you for purchasing the Personal Mobile Tool.

Before using your Zaurus: SL-6000L/SL-6000N unit, we recommend that you first 
read the separate Start-up Guide which mainly covers the set-up procedure, 
hardware operations, and common and basic software operations. Then read this 
Operation Manual which covers more in-depth software operations.

Some of the accessories described in the manuals of the Zaurus may not be 
available at the time you purchase this product.

The screens on the unit may differ from the screens in the manuals. If you would like 
to change the screen appearance on the unit, please use the “Appearance” 
application (see the “Setting the Appearance (Appearance)” section on page 139).

The information and screens provided in the manuals of the Zaurus are subject to 
change without notice.

Copyright
It is the intent of Sharp that this product be used in full compliance with the applicable 
copyright laws and that prior permission be obtained from copyright owners 
whenever necessary.

The functions on this product (such as the calendar) provides a date range from 
January 1, 1970 (GMT) to December 31, 2037 (GMT).
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About this manual

This operation manual describes both the SL-6000L and SL-6000N. “Zaurus” is 
used when describing both models, otherwise the model name is used.
The Zaurus can be operated by either pressing keys on the keyboard or tapping an 
item (buttons, etc.) on the screen using the stylus.

• This operation manual mainly describes the stylus operation. Button or key 
operations are included, if they make it easier to carry out the function.

Keys
This manual represents keys with the following:

Screen Buttons and Menu Names
Screen buttons and menu names, such as “OK”, “File”, “Edit”, etc., are indicated 
using quotation marks.

: Home key

: Cancel key

: OK key

: Shift key

: Cursor key

: Left cursor key

: Right cursor key

: Up cursor key

: Down cursor key

Cancel

OK
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Address Book
The Address Book application allows you to manage contact information for friends, 
colleagues, etc. covering the items shown below. You can also add notes to help 
you remember contacts more easily.
Entries can be organized into categories such as “Business”, “Personal”, or you can 
create your own categories.
E-mail addresses entered in the Address Book application can be used to easily 
address e-mails in the EMail application.

Overview

The Address Book application has three major screens: 
New/Edit Address screen, Index screen, and Detail screen.

New/Edit Address screen
1. On the Applications Home screen, tap the “Address Book” application icon.

The Index screen will be displayed.
2. Tap .

The New Address screen will be displayed.
Here you can create a new Address Book entry.

“Notes...” button
Tap to attach a note.
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Index screen 

Index tab Each index tab contains two or three letters. Every time you 
tap on the tab, it will move to the next letter and start the listing 
with that letter. The letters in the tabs are not case sensitive 
and will not recognize European characters.

Direct Search
field

Tap this field and enter the first letter or the first few letters you 
would like to find for the item currently used as the sorting 
order. Entries that begin with the selected letter(s) will be 
displayed. The letters are not case sensitive and will not 
recognize European characters (The letter(s) will be cleared 
when an Index tab is tapped).

Full Name button Tap to sort the entries by full name in ascending or 
descending order.

Column button Tap to list the items for each entry, then tap the desired item. 
The selected item for each entry will be displayed. 

Data area Displays the contents of the entry. Full Name column displays 
the Last Name, First Name and Middle Name. Tap an entry to 
open the Detail screen.

Scroll bar
(for L/R)

Tap to scroll to the left or right to display the left or right 
column.

Data menu
New address Creates a new Address Book entry.
Edit address Edits a registered Address Book entry.
Delete... Deletes a registered Address Book entry.
Delete all... Deletes all registered Address Book entries.
Duplicate Duplicates an Address Book entry.
Send by 
beam...

Sends an Address Book entry using the IR port (IrDA).

Owner 
Information...

Displays the Owner Information screen which can be edited if 
necessary (excluding the category field).

Column buttons
(center, right)

Data area

Full Name button
Direct Search field

Index tab

Scroll bar (for L/R)



5 Address Book
Note:

• When the first character of the item currently used as the sorting order is 
entered, the matching entry is highlighted.

• The Index screen has three columns. By tapping-and-dragging the right 
border line of the column, you can narrow the width to see all three columns 
at once.

Detail screen
1. On the Index screen, tap an entry to see the full address details.

Or highlight the entry by using the Up or Down cursor key and then press the 
SELECT key.

Sort menu
By Full Name Sorts the entries by Full Name in ascending or descending 

order.
By *** (the 
center 
column item)

Sorts the entries by center column item in ascending or 
descending order. Select the desired column by using the List 
View Settings in Option menu.

By *** (the 
right column 
item)

Sorts the entries by right column item in ascending or 
descending order. Select the desired column by using the List 
View Settings in Option menu.

Option menu
List View 
Settings...

Allows you to customize the center column item and/or right 
column item(s) on the Index screen.

Field 
Settings...

Arranges the item(s) to be displayed on the New/Edit Address 
screen.
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Note:

• To switch between the Index and Detail screens, press the Address Book key 
on the sliding cover.

• Tapping an e-mail address colored in blue opens the EMail application to the 
New mail screen using the address as the recipient (see page 94).

• Tapping a URL colored in blue launches the Web browser application and 
displays the destination if you are connected to the Internet. This function 
works only with URLs beginning with “http://” and “https://”.

Creating a new Address Book entry

You can add a new address using the New Address screen.

1. On the Index or Detail screen, tap .
The New Address screen for a new entry will be displayed.

2. Enter the contact data in the fields.
Pressing the Tab key moves the cursor to the next entry field.
Pressing the Shift key ( ) and the Tab key simultaneously moves the cursor 
to the previous entry field.

Note:

• Tap the “Notes...” button to attach a note (see page 7).
• If you want to assign one or more category names, see the separate Start-up 

Guide for details.

3. Tap  (or press the OK key) to save the new entry.
The New Address screen returns to the Index screen.
If you tap , the new entry is canceled.

Note:

• An Address Book entry cannot be saved if only the Gender field and Category 
field are completed.

• You can enter multiple e-mail addresses in the Emails field by inserting a 
comma between them. Each e-mail address entered can be used as an e-mail 
address in the EMail application.

• In some fields, the first letter will automatically be saved as uppercase 
(capital).
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Attaching a Note

You can enter a note to go with the address.

1. On the New Address or Edit Address screen, tap the “Notes...” button.
The Enter Note screen will be displayed.

2. Enter your note and tap  (or press the OK key) to save it.
The Enter Note screen returns to the previous screen.
If you tap  on the Enter Note screen, the attached note is canceled.
To save the entry with a note attached, tap  on the New Address or Edit 
Address screen.

Modifying an Address Book entry

1. On the Index screen, highlight the entry you want to modify by using the Up or 
Down cursor key.

2. Tap .
The Edit Address screen will be displayed.

3. Tap any field requiring change and modify the entry.
4. Tap  to save the modification.

The Edit Address screen turns to the Index screen.
If you tap , the modification is canceled.
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Duplicating an Address Book entry
1. On the Index screen, highlight the entry you want to duplicate by using the Up 

or Down cursor key.
2. Tap the “Data” menu and then tap “Duplicate”.

The duplicated entry will be added on the Index screen.

Deleting an Address Book entry
1. On the Index screen, highlight the entry you want to delete by using the Up or 

Down cursor key.
2. Tap  (or tap the “Data” menu and then tap “Delete...” ).

A confirmation message will be displayed before the entry is deleted.
If you want to delete all entries from the Address Book application, 
tap the “Data” menu and then tap “Delete all...”.

3. Tap “Yes” to complete the deletion.
The entry will be deleted.

Arranging the entry fields
You can change the order of the fields and hide unnecessary fields on the New/Edit 
Address screen.

Note: The first three fields (First Name, Last Name and Category) and the last 
field (Gender) cannot be arranged.

1. On the Index or Detail screen, tap the “Option” menu and then tap “Field 
Settings...”.
The Field Settings screen will be displayed, and the fields following the 
Category field are listed in current order:

“Up” button
“Down” button

“Default” button
Tap to reset the setting.
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2. Select (or clear) the fields you (do not) want to display by tapping checkboxes.
3. Tap the field you want to move, then tap the “Up” or “Down” button (or press and 

hold the Shift key ( ) and then press the Up or Down cursor key) to move the 
selected field upwards or downwards to the desired position.

4. Tap  to save the settings.
The Field Settings screen returns to the previous screen.
Your setting will be displayed on the New/Edit Address screen.
If you tap , the setting is canceled.

Arranging the display items on the Index 
screen

The display items of the center and right columns can be changed to other items 
(Scroll to the right to display these two columns).

1. Tap the “Option” menu and then tap “List View Settings...”.
The List View Settings screen will be displayed.

2. Tap each drop-down list button and select the display item.
3. Tap  to save the settings.
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Note:

• On the Index screen, you can arrange the display item following the procedure 
below instead of using the Option menu:
1. On the Index screen, tap the center or right column button that includes the 

items you want to change.
The item list is displayed.

2. Tap the desired item.
The entry of the item selected will be displayed.

• If you select “Home Address” or “Work Address”, the contents for Home or 
Work Street, City, State, Zip, and Country fields will be displayed.

Changing the sort order of the entry

You can sort the entries by Full Name, center or right column item on the Index 
screen.

1. On the Index screen, tap the “Sort” menu.
The menu displays sorting order, the Full Name, center and right column. The 
item that decides the current sorting order is checked.

2. Tap the item that decides the desired sorting order and then select “ascend” or 
“descend”.
The entries on the Index screen will be sorted depending on the selection.

Note: The items in the “Home Address” and “Work Address” cannot be sorted. 
If the center or right column items are set to “Home Address” and “Work 
Address”, sorting order in the menu appear dimmed.

Registering/Editing your personal 
information (Owner Information)

1. On the Index screen, tap the “Data” menu and then tap “Owner Information…”.
Owner Information screen will be displayed.

2. Tap  and then enter your information on Edit Owner Information screen that 
appears.

3. Tap  to save the settings.
Owner Information screen will be displayed listing your information.

4. Tap .
Or tap the “Data” menu and then tap “Owner Information…”.
The display returns to the Index screen.
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Note:

• On the Owner Information screen, you will not be able to select or enter the 
category name.

• The personal information registered during the initial setup procedure will be 
displayed on the Owner Information screen of step 1 above (see the separate 
Start-up Guide, “Registering your personal information” in “Step 3: Initial 
settings”).
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Calendar
The Calendar application is used to store events and to set reminder alarms. Using 
the Calendar screen, you can view files that have the same date information as the 
date displayed and that you transferred from your PC, created or modified in other 
applications. You can also see the Todo task entries for “Today” stored in the Todo 
List application.

Overview

You can view one day, one week, one month or one year at a time. Tap the “View” 
menu, then select “Day”, “Week”, “Month” or “Year”.
By selecting “Today” from the “View” menu, you can display a view including today.
To switch views, you can use the view icons from the Menu bar:  (Today),  
(Day),  (Week),  (Month) and  (Year) on the Menu bar for switching views.

Day view
1. On the Applications Home screen, tap the “Calendar” application icon.
2. Tap the Day view icon ( ).

The Day view has three tabs.

Event tab Displays the Event screen in the timetable for the events of 
the day and Todo task entries (only for “Today”).

Agenda tab Displays the Agenda screen listing the events of the day 
and Todo task entries (only for “Today”).
Tap the event to open its Detail screen. 

File link tab Displays the File link screen listing files of the same date as 
the event of the day. Tap a file to open it.
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View icons
(Today, Day, Week, 
Month, Year)

Previous button

Next button

Date button

Event tab

Event indication 
(Focused status)

: Event with an Alarm 
setting

: Repeating events
: Events of less than 

one hour 
(indicated in red on 
the left of the 
schedule title)

Event screen

Agenda screen File link screen

Indicates the files linked to 
the Calendar date.

Column buttons
These four columns can 
change their position by 
tapping-and-dragging them 
to the desired direction. 

File link tab
Agenda tab

Todo task entries linked
from the Todo List

application

Time buttons
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Note:

• The Event screen in the Day view shows the pop-up menu by tap-and-holding 
the Event, allowing you to edit or delete.

• The Event screen shows up to 10 events in the case of multiple events with 
overlapping times.

• All day events are displayed above the time table.
• Todo task entries for “Today” can be displayed on the Event and Agenda 

screens in the Day view that can be displayed when you tap  (Today) 
(Incomplete entries over the Due Dates will be displayed in red).
You can select or clear the completed checkbox on those screens. Tapping a 
Todo task entry will launch the Todo List application and will open the Detail 
screen (see page 32).

View icons
Today Displays the selected view for today.
Day Displays the Day view.
Week Displays the Week view.
Month Displays the Month view.
Year Displays the Year view.

Date button Tap to select the desired day from the mini-calendar.
Previous button Moves to the previous date.
Next button Moves to the next date.
Time buttons Tap or drag time buttons to open the New Event screen with 

the Start and End time entered.
Event indication
(Focused status)

Displays the registered events.
Press the Up or Down cursor key to move the focus. Then 
press the SELECT key or OK key to open the Detail 
screen.
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Displaying Todo task entries

You can display Todo task entries in the Day view of the Calendar application.

Todo task entries which should be performed today can be displayed in Day view of 
the Calendar application.
Items to be displayed are listed in the Note below. If you do not want to display Todo 
task entries, select “Todo Tasks”, then “Hide” from the View menu.

Note:

• Todo task entries to be displayed are those
• Todo item that is past the start date and no past the due date
• Todo item that is past the start date and does not have a due date
• Todo item that is past the start date and due date (displayed in red)
• Todo item with completed date set to today. (displayed with a strikethrough 

line)
• Some of the Todo items above are not be displayed depending on the Start/

Due/Completed dates.

Tap the checkbox 
to indicate that a 
Todo task has 
been completed.
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Week view
1. Tap the Week view icon ( ).

The Week view has two tabs.

Event tab Displays the Event screen in the timetable for the 
events of the week.

Agenda tab Displays the Agenda screen listing the events of the 
week.
Tap the event to open its Detail screen.

Event tab

Week spinbox
Agenda tab

Date button

Event indication
Green bar:All day event
Red bar: Event with an 

Alarm setting
Blue bar: Event with 

Start and End 
time setting

Next button

Focused day (in amber)
Press the Right or 
Left cursor key to 
move the focus. 
Then press the OK 
key or the SELECT 
key to open the Day 
view.

Event screen

Agenda screen

Day of the week buttons

Previous button
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Note: The Event screen in the Week view shows up to four events in the case 
of multiple events with overlapping times.

Date button Displays the start date of the selected week.
Tap to select the desired day from the mini-calendar.

Week spinbox Select the week of the year.
Tap  to move to the next week, or tap  to 
move to the previous week.

Day of the week buttons Tap to open the Day view of the selected day.
Previous button Moves to the previous week.
Next button Moves to the next week.
Event indication Tap to display the detailed contents of the event for a 

few seconds.
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Month view
The Month view is composed of two views: Text view and Graph view.
In the Date cell, the Text view shows a part of the event description, and the Graph 
view shows events in symbol.
To switch these two views, tap the “View” menu, then tap “Month View”, and then 
select “Text” or “Graph”.

Text view

Graph view

: Date with a Link file

Date cell

Year spinbox

Next button

To December button

Focus frame

Today (amber Date cell)

Agenda of the day focused

To January button

Previous button

Month drop-down
list button

Colored events mean:
 (green):Schedule spanning days which starts and ends at different day
 (blue): Schedule starting before noon, or schedule for all day
 (red): Schedule starting after noon
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Year view

Note: To scroll the Year view screen, press the cursor keys.

To January button Moves to January of the selected year.
Previous button Moves to the previous month.
Month drop-down list 
button

Tap to select the desired month.

Year spinbox Select the year.
Tap  to move to the next year, or tap  to 
move to the previous year.

Next button Moves to the next month.
To December button Moves to December of the selected year.
Date cell Tap to focus on a day. Tapping the focused day 

(again) displays the Day view of that day.
Focus frame Press the cursor keys to move the focus. Then press 

the OK key or the SELECT key to open the Day view.
Agenda of the day focused Displays the event list of the day focused.

Previous button Moves to the previous year.
Next button Moves to the next year.
Year drop-down list button Tap to select the desired year.

Previous button

Year drop-down
list button Next button

Tap-and-drag the stylus 
on any day to enlarge 
the day number. 
Release the stylus to 
display the focused day 
in the Day view.

Today (highlighted)
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Detail screen

Specific Menu commands of the Calendar application
Data menu

Delete 
period...

Deletes the selected daily, weekly, monthly events at once.

View menu
Today Displays the selected view for today.
Day Displays the Day view.
Week Displays the Week view.
Month Displays the Month view.
Year Displays the Year view.
Day File View Selects the display format of the File link screen in the Day 

view: List or Thumbnails.
Month View Selects the display format of the Month view: Text or Graph.
Todo Tasks Selects whether to display Todo task entries for today or not.

Option menu
Alarm and 
Start Time

Sets the starting time on the Event screen in the Day view or 
Week view mode, and the Alarm setting when creating a new 
event.

Link File With the memory card inserted, selects whether link files on 
the memory cards are displayed in the Month view and the 
File link screen of the Day view.

Detailed information
Tap  or press the 
Cancel key to close 
the Detail screen.
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Viewing the link files

On the Calendar application, you can view Imaging, Text Editor, 
HancomMobileWord, HancomMobileSheet files and files copied from a PC or other 
source. The File link screen displays files created or modified on the same date as 
a selected Calendar date.

1. In the Day view, tap the File link tab.
The File link screen will be displayed with files linked to the date.

2. Tap the desired file to open it.

Note:

• The File link screen can display the following files:
- Files transferred from a PC (on the transfer dates)
- Files created or modified in the Zaurus (on the creation or modification 

dates)
• To change the view mode of the File link screen:

1.On the File link screen, tap the “View” menu and then select “Day File 
View”.

2.Tap “Thumbnails” or “List”.
• To change the dates that are linked to a file, see page 22.

Selecting the link option for the memory card

You can select to link files on the memory cards to the Zaurus. However, to reduce 
start-up time for the Calendar application and/or the display time for linked files, you 
may want to unlink excess files on your memory cards.

1. Tap the “Option” menu and then tap “Link file”.
2. Tap “CF Card” or “SD Card” to select or clear.

The files on the checked memory card will be linked.
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Changing the date to link files

As you change the date of the files, they will be displayed on the File link screen of 
the date you change. You can then manage files according to your schedule of 
events.

1. Open the File link screen with a file of the date you want to change.
2. Tap and hold the stylus on the file to display the pop-up menu.
3. Select “Move”.

The mini-calendar will be displayed.
4. Tap the new date you wish the file to be linked to from the mini-calendar.

The date information of the file will be changed and the file will be displayed on 
the File link screen of the new date.

Adding an Event entry

1. On any of the Calendar view screen, tap .
The New Event screen will be displayed.

2. Select/Enter the event contents.
• For Description and Location, you can either select from the list or enter your 

own. Entered items are added to the list. When items exceed 20 in number, 
the oldest one will be deleted.

• Select the desired category from the drop-down list (“Unfiled” is the default). 
You can add more category names. See the separate Start-up Guide for 
details.

• To change the Start/End date, tap the Start or End date button and select the 
desired day from the mini-calendar that pops up.

Alarm sound on/off 
drop-down list button

Repeat button

All day checkbox
Start/End date buttons

Alarm checkbox

Start/End time combobox 
buttons

Time zone drop-down
list button

City Time button

Notes field
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• The Start or End time will be entered automatically if you tap and drag the 
time buttons on the Event screen (the Day view) to specify the time. To 
change the time, enter the time directly or tap Start or End time combobox 
buttons.

• For an All day schedule, select the All day checkbox. With this box selected, 
you cannot specify the Start and End time nor the time zone, etc.

• You can change the time zone by tapping the City Time button
(see page 122, “To change cities”).

• You can set an event alarm (see below, “To set an alarm”).
• You can make a repeating event (see below, “To repeat an event”).
• You can enter a note in the Notes field.

3. Tap  to save the new event entry.
The New Event screen turns to the previous screen.

To set an alarm
1. On the New Event screen, select the Alarm checkbox.
2. Set the amount of time prior to the event you want the alarm to ring.
3. Tap the Alarm sound on/off drop-down list button, and select “Silent” or “Loud”.

• The alarm will ring and the Alarm screen will be displayed at the set time, 
even if the Zaurus is off (Tap “OK” to close the Alarm screen).

• The alarm will not ring with the following settings:
– The alarm setting is “Silent”.
– The Mute checkbox is selected, or the Alarm checkbox is not selected (Tap 

the Sound volume icon on the taskbar).
• You can make the Mail light (Email LED) flash at an alarm (pre)set time (see 

pages 28 and 29).

Note: With the stereo headphone connected, you hear a sound from the 
headphone, not from the built-in speaker.

To repeat an event
1. On the New Event screen, tap the Repeat button.

The Repeating Event screen will be displayed.
2. Tap the appropriate repetition button for the event, i.e. “Daily”, “Weekly”, 

“Monthly”, or “Yearly”.
If you do not want to repeat the event, tap the “None” button.

3. Enter the necessary information (see pages 24 and 25 for details).
4. Tap  to save the repeat setting.

The Repeating Event screen returns to the New Event screen.
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Daily Events 

1. Tap the Every spinbox to set the number of days between each repeat.
2. If the event has an end date, uncheck the “No End Date”, then tap the End Date 

button, and choose an end date from the mini-calendar.

Weekly Events 

1. Tap the Every spinbox to set the number of weeks between each repeat.
2. If the event has an end date, clear the “No End Date”, then tap the End Date 

button, and choose an end date from the mini-calendar.
3. To add day(s) of the week the event should repeat, tap the relevant Repeat On 

button(s).
To clear the added day(s) of the week, tap the same Repeat On button(s) again.

Repeating Event screen 
(Daily)

Every spinbox
No End Date checkbox

End Date button

Repeating Event screen 
(Weekly)

Repeat On 
buttons
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Monthly Events 

1. Tap the Every spinbox to set the number of months between each repeat.
2. If the event has an end date, clear the “No End Date”, then tap the End Date 

button, and choose an end date from the mini-calendar that pops up.
3. If the event repeats by day of week (i.e. every first Thursday), tap the Repeat By 

“Day” button. If the event repeats by date (i.e. every 6th), tap the Repeat By 
“Date” button.

Annual Events 

1. Tap the Every spinbox to set the number of years between each repeat.
2. If the event has an end date, clear the “No End Date”, then tap the End Date 

button, and choose an end date from the mini-calendar that pops up.

Repeating Event screen 
(Monthly)

Repeat By 
buttons

Repeating Event screen 
(Yearly)
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Modifying an Event entry

1. On the Event screen of the Day view, tap and hold the event entry you want to 
modify.
The pop-up menu will be displayed.

2. Select “Edit event”.
Or on the Detail screen, tap  instead of performing steps 1 and 2.
The Edit Event screen will be displayed.

3. Modify the event.
4. Tap  to save the modification.

The Edit Event screen returns to the previous screen.

Note:

• If you modify a repeating event, all occurrences of the event will be modified.
• You can perform the same operation in step 1 from the Agenda screen of the 

Day view/Weekly view.
• You cannot modify the time zone. To change the time zone, delete the entry 

and create a new one with the desired time zone.

Duplicating an Event entry

1. Highlight the event you want to duplicate from the Event screen of the Day view 
by using the Up or Down cursor key.

2. Tap the “Data” menu and then tap “Duplicate”.
The selected event will be duplicated.

Note: You can perform the same operation in step 1 from the Agenda screen 
of the Day view/Weekly view.
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Deleting an Event entry

Deleting an event entry
1. On the Event screen of the Day view, tap and hold the event entry you want to 

delete.
The pop-up menu will be displayed.

2. Select “Delete...”.
Or instead of performing steps 1 and 2, tap  on the Detail screen.
A confirmation message will be displayed before the entry is deleted.

3. Tap “Yes” to delete the event.
The event will be deleted permanently.

Note:

• If you delete a repeating event, all occurrences of the event will be deleted. 
A single occurrence cannot be deleted solely.

• You can perform the same operation in step 1 from the Agenda screen of the 
Day view/Weekly view.

Deleting Daily, Weekly or Monthly events
You can delete all the events for a given day, week or month (except for repeating 
events) at one time.

1. Open the Calendar screen in the Day, Week, or Month view in which you want 
to delete events.

2. Tap the “Data” menu and then tap “Delete period...”.
3. Tap the drop-down list button on the screen that will be displayed and then tap 

as follows:
For the events of a day, tap “Events in selected day”.
For the events of a week, tap “Events in selected week”.
For the events of a month, tap “Events in selected month”.

4. Tap “Yes”.
A confirmation message will be displayed before the events are deleted.

5. Tap “Yes” to delete the events.
The events will be deleted permanently.
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Note:

• Events cannot be deleted from the File link screen in the Day view. On the File 
link screen, you will delete files, not events.

• Repeating events cannot be deleted by periodic deletion.
• Events over successive days, weeks and months within the specified date 

period will be deleted entirely.

Deleting all Calendar event entries
1. In any view mode of the Calendar application, tap the “Data” menu and then tap 

“Delete all...”.
A confirmation message will be displayed before the events are deleted.

2. Tap “Yes” to delete all events.

Note:

• Deleting all events cannot delete their link files.
• Event entries cannot be deleted from the File link screen.

Calendar Setup

You can change the starting time on the Event screen in the Day view or Week view 
mode, and the Alarm settings on the New/Edit Event screen, etc.

1. In any view mode of the Calendar application, tap the “Option” menu and then 
tap “Alarm and Start Time...”.
The Alarm and Start Time screen will be displayed.

Start Time spinbox

Alarm Preset spinbox

Alarm Preset
checkbox

Email LED Blink
checkbox
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2. Make the necessary settings and then tap  to save the settings.
The Alarm and Start Time screen returns to the previous screen.
If you tap , the setting is canceled.

Start viewing events
Start Time 
spinbox

Set the earliest time you want to show when you open the 
Event screen in the Day or Week view mode.

Alarm Settings
Alarm Preset 
checkbox

Select to set the Alarm preset time.

Alarm Preset 
spinbox

Set the Alarm preset time.
If you set the preset time to “5 minutes”, for example, the 
alarm sounds five minutes before the event.
This setting will be the default alarm setting on the New Event 
screen.

Email LED 
Blink 
checkbox

When selected, the Mail light (Email LED) flashes at an alarm 
(pre)set time (The Zaurus then performs Auto power off, and 
the Mail light (Email LED) will go out).
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Todo List
The Todo List application allows you to manage tasks and reminds you to complete 
them before the due date. Task entries can also be viewed in the Calendar 
application.
In the Todo List application, you can list them in the order of the checked status, the 
priority or description, and confirm them easily. Entries can be organized into 
categories such as “Business”, “Personal”, or you can create your own.

Overview

New/Edit Task screen
1. On the Applications Home screen, tap the “Todo List” application icon.

The Index screen will be displayed.
2. Tap .

The New Task screen will be displayed.

Description combobox Select your choice from the list or enter the desired 
description. Entered items are added to the list. When 
items exceed 20 in number, the oldest one will be 
deleted.

Start Date checkbox/
Start Date button

Select and tap the Start Date button to select the start 
date.

Due Date checkbox/
Due Date button

Select if the task is due to be completed on a specified 
date, and then tap the Due Date button to specify the 
due date.

Start Date button
Description combobox

Due Date button 

Priority drop-down list 
button

Edit Categories button

Completed Date button 

Category drop-down list 
button

Notes field
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Index screen
1. On the Applications Home screen, tap the “Todo List” application icon.

Note:

• The past-due uncompleted Todo entries will be displayed in red.
• Priority 1 task entries will be highlighted.

Completed Date 
checkbox/Completed 
Date button 

Select if the task has been completed.
To change the completed date, tap the Completed 
Date button to select the desired date.

Priority drop-down list 
button

Tap to display the list of choices and then tap your 
choice.

Category drop-down 
list button

Tap to display the list of choices and then tap your choice.
If you want to create a new category name, tap the Edit 
Categories button (see the separate Start-up Guide for 
more details).

Edit Categories button Tap to display the Edit Categories screen where you can 
edit categories or assign multiple categories to an event 
(see the separate Start-up Guide for more details).

Notes field Enter a note, if necessary.

Checked status button Tap to sort the entries by checked status (completed 
or incomplete).

Completed checkbox When cleared, the task is not completed; when 
checked, the task is completed.

Priority button Tap to sort the entries by priority.
Description button Tap to sort the entries by description.
Due Date button Tap to sort the entries by due date.

Checked status button

Completed checkbox

Priority button

Due Date button

Description button
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Detail screen
1. On the Index screen, tap the desired entry.

Creating a new Task entry

1. On the Index or Detail screen, tap .
The New Task screen will be displayed.

2. Select/Enter the task contents.
• Enter or select the description from the Description combobox.
• If the task has a start date or due date, select the Start Date or Due Date 

checkbox.
• Tap the Start Date or Due Date button and then tap the date from the 

mini-calendar.
• Tap the Priority drop-down list button and select the priority.
• Tap the Category drop-down list button to set the task’s category. You can 

also enter a desired category name. For details, see the separate Start-up 
Guide.

• Tap the Notes field and enter the task, etc.
3. Tap  to save the new entry.

The New Task screen turns to the Index screen.
If you tap , the new entry is canceled.

Note: Saved Task entries can be displayed on the Event and Agenda screens 
in the Day view for “Today” in the Calendar application (see “Calendar” 
on page 12).

Detailed information
Tap  to close the 
Detail screen.
The display returns 
to the Index screen.
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Modifying a Todo task entry

1. On the Index screen, tap and hold the entry you want to modify.
The pop-up menu will be displayed.

2. Select “Edit task”.
Or instead of performing steps 1 and 2, tap  on the Detail screen.
The Edit Task screen will be displayed.

3. Modify the entry.
Select the Completed Date checkbox if the task is completed.
If you change the completed date, tap the Completed Date button and select the 
desired date.

4. Tap  to save the modification.
The Edit Task screen will return to the Index screen.

Note: The Task status can also be changed on the Index screen (see page 34).

Duplicating a Todo task entry

1. On the lndex screen, highlight the entry you want to duplicate by using the Up 
or Down cursor key.

2. Tap the “Data” menu and then tap “Duplicate”.
The duplicated entry will be added on the Index screen.

Completed Date
checkbox
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Deleting a Todo task entry

Deleting a Todo task entry
1. On the Index screen, tap and hold the entry you want to delete.

The pop-up menu will be displayed.
2. Select “Delete…”.

Or instead of performing steps 1 and 2, tap  on the Detail screen.
A confirmation message will be displayed before the entry is deleted.

3. Tap “Yes” to delete the entry.
The entry will be deleted.

Deleting all Todo task entries
1. On the Index screen, select “All” from the “Category” menu.
2. Tap the “Data” menu and then tap “Delete all...”.

A confirmation message will be displayed before the entries are deleted.
3. Tap “Yes”.

All entries will be deleted.

Note: When either incomplete or completed entries are viewed using the 
“View” command on the “Option” menu, only viewed entries will be 
deleted (see below).

Checking a completed entry on the Index 
screen

After completing a Todo task, select the Completed checkbox on the Index screen 
or the Todo task entry will be recognized as incomplete.

1. On the Index screen, tap the Completed checkbox of the completed entry.
To remove the check, tap the Completed checkbox again.

To view only the incomplete/completed entries
1. On the Index screen, tap the “Option” menu and then tap “View”.
2. Tap “Hide completed tasks” or “Only completed tasks”.

Only incomplete or completed entries will be displayed (see the description on 
the title bar).
To show all entries in both status, select “Show completed tasks”.
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Imaging
Imaging allows you to handle image files. You can view and add comments to image 
files copied from your PC. You can easily handwrite memos. And, Imaging can 
display BMP, JPEG, GIF and PNG formats. Imaging files can also be displayed on 
the Files Home screen.

Overview

Index screen
1. On the Applications Home screen, tap the “Imaging” application icon.

An Index screen will be displayed. If the Detail screen is displayed instead of the 
Index screen, press  to switch to the Index screen. 

Folder menu Tap to change folders when you want to view files in another 
folder or on a memory card.

History button Tap to list the files you have previously opened.

Folder menu
Indicates the current 
folder name.

Files within the 
Image_Files folder 

History button

Moves to the folder 
one level up than the 
current folder.
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Image view screen
1. On the Index screen, tap the desired file.

The Image view screen will be displayed.

File menu
Rename... Renames the image file (see page 41).

View menu
List Lists the image files by name (see page 46).
Thumbnails Lists the image files by thumbnails

(see page 46).
List View 
Settings...

Customizes the items to be displayed on the Index screen 
(see page 46).

Refresh 
Icons

Updates icons of the image files modified in the thumbnail 
view.

Option menu
Rotate Left Rotates the selected image 90 degrees counterclockwise and 

saves it (see page 42).
Slideshow Displays a slideshow of image files in the current folder (see 

page 43).
Preferences... Configures the slideshow settings. Changes how the Image 

view screen will be displayed and how the Cancel key on the 
Index screen performs (see page 44).

Zoom In

Tap to return to the 
Index screen.

Zoom Out
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Note:

• If a file is larger than the screen, you can scroll to the hidden part by dragging 
across the screen with the stylus.

• Imaging can handle images up to 1024 × 768 pixels. Some larger images can 
be displayed, but you may encounter improper scrolling or corruption of the 
image display (The image file itself will not be damaged). It will also take a long 
time to save or rotate the image.

• When the same image is displayed on the Zaurus and the PC, there may be 
differences such as variations in rendering colors.

• It may be impossible to display some image files.
• Imaging may close unexpectedly due to insufficient memory when attempting 

to display, rotate, or otherwise manipulate large image files.

View menu
Fullscreen Displays the image on the full screen with no Menu bar or 

taskbar on it (Images larger than the display will be 
reduced). Press the Cancel key to return to the normal 
screen.

Flip Horizontal Flips the image horizontally.
Flip Vertical Flips the image vertically.
Rotate by 180 Rotates the image by 180°.
Rotate by 90 Rotates the image by 90° counterclockwise.
Rotate by 45 Rotates the image by 45° counterclockwise.
Zoom In Magnifies the image file.
Zoom Out Reduces the image file.

Option menu
Slideshow Displays a slideshow of the image files in the current folder 

(see page 43).
Preferences… Configures the slideshow settings. Changes how the Image 

view screen will be displayed and how the Cancel key on 
the lndex screen performs (see page 44).
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New File/Edit screen
1. On the Index or Image view screen, tap .

File menu
Save Saves the image file.

Edit menu
Undo Undoes the last operation.
Clear image Deletes the selected part.
Drawing Tools Selects the tool: Pen, Eraser, Line, Square 

and Circle and Select. These tools can be 
selected by tapping the shortcut icons on the 
Menu bar.

Line Color Specifies the line color.
Fill Color Specifies the background color for a Square 

and Circle.
Line Width Specifies the line width: Small, Medium, or 

Large.
Image Flip/Rotate

Flip 
Horizontal

Flips the image horizontally.

Flip Vertical Flips the image vertically.
Rotate by 
180

Rotates the image by 180°.

Rotate by 90 Rotates the image by 90° counterclockwise.
Rotate by 45 Rotates the image by 45° counterclockwise.

Shortcut icon for 
selecting Line Color

Shortcut icons for 
selecting Tools
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Writing memos by hand (creating new memos)

Writing memos
1. On the Index or Image view screen, tap .

The new image screen will be displayed. 

2. Tap the Pen icon and write a memo.
To erase a portion, tap the Eraser icon and drag the stylus across the area to 
erase.

3. When finished writing, tap .
When an expansion memory card is inserted in the Zaurus, the screen for 
selecting the destination will be displayed.

4. Select the destination.
• The memo will be saved in the Image_Files folder with the filename showing 

the date and time as follows: Date_Time (MMDD_HHMM).
• If the file is saved on the memory card it will be saved in CF Card (SD Card)/

Documents/Image_Files.

Note:

• The filename can be changed using the “Rename” function in the “File” menu 
on the Index screen (see page 41).

• Files created by handwriting will be saved in the PNG format. Their size will 
be as follows:

horizontal display: 640 × 370 pixels
vertical display: 480 × 530 pixels

Pen icon Eraser icon
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Drawing straight lines, squares, and circles
1. To draw a straight line in a newly created image, tap .

To draw a square, tap .
To draw a circle, tap .

2. Set the line color and fill color (see below).
3. Use the stylus to draw the line, square, or circle.

Note: Because the screen is made up of pixels, inclined lines will not be 
perfectly straight.

Selecting the pen and line color
Select the pen color, straight line color, and square or circle line color.

1. Tap  on the new image screen.
On the color palette, select the color by tapping it.

Selecting the Fill Color
You can select the interior color for squares and circles.

1. On the new image screen, tap the “Edit” menu and then tap “Fill Color”.
2. Tap the color palette to select the color.

Selecting the line width
1. On the new image screen, tap the “Edit” menu and then tap “Line Width”.
2. Tap the desired line width.

Specifying an area and erasing its contents
1. Tap  on the new image screen.
2. Drag the stylus to outline the area to be erased.
3. Tap the “Edit” menu and then tap “Clear image”.
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Modifying a memo (image file)

You can edit files on the Edit screen.

1. On the Index screen, highlight the file you want to edit by using the cursor key.
2. Tap .

The Edit screen will be displayed.
3. When finished editing, tap .

Caution! Some image files may change to a lower resolution if edited. Make a 
copy before editing an important file, and edit the duplicated file.

Note:

• Image files in GIF format will change into PNG format when edited. 
• Do not rotate the image while editing the data.

Deleting a memo (image file)

1. On the Index screen, highlight the file you want to delete by using the cursor 
key.
Or open the Image view screen of the file.

2. Tap the “File” menu and then tap “Delete…”.
A confirmation screen will be displayed.

3. Tap “Yes” to delete.

Caution! When you select a folder in step 1 above, all files (including non-
image files) are deleted. Check that no important files (of any type) 
are in the folder selected for deletion.

Changing filenames

1. On the Index screen, highlight the file you want to rename by using the cursor 
key.

2. Tap the “File” menu and then tap “Rename...”.
The Rename screen will be displayed.

3. Change the filename, then tap  to save.
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Rotating the image 90 degrees and saving it

This procedure is used to rotate an image by 90° (counterclockwise) and save it in 
the rotated condition. When a horizontal image like a photograph is rotated by 90° 
and saved, it will appear larger in the full screen view.

1. On the Index screen, highlight the file you want to rotate by using the cursor key.
2. Tap the “Option” menu and then tap “Rotate Left”.

A confirmation screen will be displayed.
3. Tap “Yes” to save.

Note:

• You cannot perform this operation on the Image view screen.
• GIF format image files will change into PNG format when saved.

Viewing a single image

1. On the Index screen, tap the image file you want to view.
The selected image will be displayed.

2. Tap  or press the Cancel key to return to the Index screen.

Magnifying or reducing the image
You can zoom in or out of a large-size image file on the Image view screen.

1. In the Image view screen, tap  (Zoom In) or  (Zoom Out).
The image will be magnified or reduced.

Viewing the full screen display
1. On the Image view screen, tap the “View” menu and then tap “Fullscreen”.

The image file display will fill the entire screen (full screen mode).
• Pressing the Up or Down cursor key will display the previous or next image 

file. If the image is large, it will take time to convert the image.
• To return to the original view, press the Cancel key.
• Images that are larger than the screen will be reduced to fit.
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Rotating or reversing images
1. On the Image view screen, tap the “View” menu and then tap “Rotate by 180”, 

etc.
The image file will be rotated or reversed according to the command.

Displaying a slideshow of the files

All image files in a folder will be opened once from the top of the list in the full screen 
mode. Be sure to collect image files into a folder and arrange them in an order by 
renaming them, for example, with “01” or “02”, beforehand.

1. On the Index screen, tap the Folder menu and select the folder including image 
files you want to display a slideshow.

2. Tap the “Option” menu and then tap “Slideshow”.
When the slideshow is finished, the display returns to the Index screen.
• If the Auto-play option is cleared, the first file on top of the list will be opened 

(For information on the Auto-play option and others, see page 45).
• When the Auto-play option is cleared, pressing the Right or Down cursor key 

will display the next file, while pressing the Left or Up cursor key will display 
the previous file.

• To stop the slideshow, press the Cancel key. The display returns to the Index 
screen.
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Changing Image view screen, the Cancel key 
actions, and slideshow settings

You can remove or display the scroll bar or status bar in the Image view screen and 
change the action of the Cancel key in the Index screen.
Changing the action of the Cancel key is useful when you have files sorted into 
various folders, because it allows you to search for files using key operations.

1. On the Index screen or Image view screen, tap the “Option” menu and then tap 
“Preferences…”.

Display Options
Show 
scrollbar

Remove the checkmark when you want to widen the Image 
view screen by displaying it without the scroll bar. 

Show 
statusbar

Place a checkmark to display the status bar on the Image 
view screen, showing information like the image size of the 
opened file. 

Show 
fullscreen

Place a checkmark to always open files in the full screen 
mode. 

Cancel Key Function
Use cancel 
as close

When the Cancel key is pressed on the Index screen, this 
application will be closed. 

Use cancel 
as up

When the Cancel key is pressed on the Index screen, the 
display changes to an Index screen for the folder above the 
current folder.

Use cancel 
as focus

When the Cancel key is pressed on the Index screen, it 
cycles the focus through Folder menu, History button, etc. In 
this situation, the focused item can be selected through key 
operations by pressing the SELECT key.
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Note: When the scroll bar and status bar are set to display, the Image view 
screen will look like the example below.
In the full screen mode, the scroll bar and status bar will not be 
displayed.

2. When finished changing the settings, tap  to save them.

Slideshow setting
Auto-play 
checkbox

If selected, files will be automatically opened after the present 
file has displayed a preset amount of time.

Repeat 
checkbox

If selected, files will be automatically opened repeatedly.

Delay time 
slider

If the Auto-play option is checked, move the slider to adjust 
the delay time before the next file is displayed.

Scroll bar

Scroll bar

Status bar
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Switching the view mode on the Index Screen

Changing from Thumbnail view to List view
1. On the Index screen, tap the “View” menu and then tap “List”.

Tapping “Thumbnails” on the “View” menu will return to the thumbnail view.

Changing the items displayed on the list screen
The display items of the center and right columns can be changed to other items.

1. On the Index screen, tap the “View” menu and then tap “List View Settings...”.
The List View Settings screen will be displayed.

2. Tap each drop-down list button and select the item to be displayed.
3. Tap  to save the settings.

Column buttons
Tap to sort the files 
by the column item.

List view

Center column
Right column
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Text Editor
The Text Editor application allows you to manage (create, edit) a simple text file and 
synchronize with Microsoft® Outlook® to synchronize Notes entries.
This application has two Index screens: Text Index screen and Notes Index screen. 
By default, created text files are saved in the Text_Files folder in the Internal Flash 
memory.
The Notes Index screen manages note entries you can synchronize with Microsoft® 
Outlook® Notes on a PC using synchronization software (provided in the CD-ROM). 
The files in the Text_Files folder cannot be viewed from the Notes Index screen and 
cannot be synchronized with a PC.

Overview

Use the tabs to switch between Index screens.

Index screen (Text tab)
1. On the Applications Home screen, tap the “Text Editor” application icon.

The Text Index screen will be displayed.
The Text Index screen displays a list of text files you can open.

Column buttons
Tap to sort files.

Folder menu Moves to the folder up 
one level than the 
current folder.

History button
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Note: To view the contents of a text file, tap the desired text file. The file will be 
opened so that you can edit it.

Folder menu Tap to switch folders to display text files stored in other 
folders or on a memory card.

History button Tap to list the files you have previously opened.
File menu

Rename... Renames the file name.
Convert to 
Notes

Copies a text file and saves it as a Notes file.

Option menu
Preferences... Defines how the Cancel key operates on the Index screen.
Code 
Preferences...

Selects the character code for opening or saving files.

Help Displays online help.
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Index screen (Notes tab)
1. On the Text Index screen, tap the Notes tab.

The Notes Index screen (yellow background) will be displayed listing note 
entries for synchronizing with Microsoft® Outlook® on a PC. 

Note: To view a note entry, tap the file and it will be opened allowing you to edit 
it.

File menu
Convert to Text Copies a note entry and saves it as a text file.
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New/Edit screen (Text/Notes)
1. Tap  to create a new file/entry or tap the file on the Index screen (with the Text 

or Notes tab).
The New/Edit screen according to the tab will be displayed (Screens for Notes 
are displayed in yellow).

File menu
New Creates a new text file or note entry.
Save Saves the current file/entry.
Save As Saves the current file as a new file (for Text tab only).

View menu
Font Changes the display font size.
Wrap lines When checked, carriage return is inserted into the text 

according to the width of the screen.
Code 
Preferences...

Selects the character code for opening or saving files (for 
Text tab only).

Edit area

File menu
View menu
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Creating a new text file (Text Index screen)

1. Tap the Text tab.
The Text Index screen will be displayed.

2. Tap .
The New Text screen will be displayed.

3. Enter text, then tap .
The screen for entering a new file name will be displayed.

4. Select the desired folder to save a new file using Folder menu, etc.
5. Enter a file name in the File name entry field.
6. Tap  to save the new file.

If you tap , the screen returns to the New Text screen before tapping  
in step 3 (The text file has not been saved yet).

Creating a new note entry (Notes Index 
screen)

1. Tap the Notes tab to display the Notes Index screen.
2. Tap .

The New Notes screen will be displayed.
3. Enter text and then tap  to save the new note entry.

Note:

• The new note entry will be named automatically with the first character(s) (up 
to 20) entered in the body of the note.

• Note entries are created for data synchronization and cannot be shown on the 
Files Home screen.

File name entry field

Folder menu Tap to create a new 
folder.
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Modifying a text file/note entry

1. On the Text or Notes Index screen, tap the file/entry you want to edit.
The Edit screen will be displayed.

2. Edit the text file/note.
3. Tap  to save the modification.

The display returns to the Text/Notes Index screen.

Deleting a text file/note entry

1. On the Index screen, highlight the text file or note entry you want to delete by 
using the Up or Down cursor key.

2. Tap .
A confirmation message will be displayed before the text file/note entry is 
deleted.

3. Tap “Yes” to delete.
The text file/note entry will be deleted.

Caution! When you select a folder in step 1 above, all files (including non-text 
files) are deleted. Check that no important files (of any type) are in 
the folder selected to be deleted.

Duplicating a text file to/from a note entry

You can copy a text data between a text file and note entry, and save it.

1. On the Text or Notes Index screen, highlight the text file or note entry you want 
to convert by using the Up or Down cursor key.

2. Tap the “File” menu and then tap “Convert to Notes” or “Convert to Text”.
When you select “Convert to Notes”:

The created note entry will be displayed in the Notes Index screen.
When you select “Convert to Text”:

The screen for entering a file name will be displayed.
Modify the file name, if necessary and then tap  to save the text file.

Note: When you convert a text file using the “Convert to Notes” menu, the file 
name of the text file will be the first line of the converted note entry.
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Setting the wrap lines

1. On the New/Edit screen, tap the “View” menu and then tap “Wrap lines”.
• The wrap lines setting helps you to read texts easily.
• To cancel the wrap lines setting, follow step 1 and clear “Wrap lines”.

Renaming a text file

1. On the Text Index screen, highlight the text file you want to rename by using the 
Up or Down cursor key.

2. Tap the “File” menu and then tap “Rename...”.
The Rename screen will be displayed.

3. Modify the current file name.
4. Tap  to save the new name.

Defining the Cancel key function for the Text 
Index screen

You can define how the Cancel key operates on the Text Index screen. There are 
three choices.

1. On the Text Index screen, tap the “Option” menu and then tap “Preferences...”.
The Preferences screen will be displayed.
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2. Tap the desired radio button and then tap .

Selecting the character code for opening or 
saving files

Set up the type of character code used when transferring files between the Zaurus 
and a PC.
Select “Latin-1” for transferring files with a Windows PC. The Latin-1 can also be 
selected if the Zaurus is used without a PC.

1. On the Text Index screen, tap the “Option” menu and then tap “Code 
Preferences...”.
The Code Preferences screen will be displayed.

2. Tap the following character code drop-down list button:

3. Tap  to save the settings.

Use cancel as close When the Cancel key is pressed on the Index screen, 
this application will be closed. 

Use cancel as up When the Cancel key is pressed on the Index screen, 
the display changes to an Index screen for the folder 
above the current folder.

Use cancel as focus When the Cancel key is pressed on the Index screen, 
it cycles the focus through Folder menu, History 
button, etc. In this situation, the focused item can be 
selected through key operations by pressing the 
SELECT key.

Open file as Correctly opens files transferred from a PC depending 
on the character code selected.

Save file as Saves files by specifying a character code for the 
transfer destination (PC).
(Created files can be opened on the PC.) 
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Media Player
The Media Player application allows you to play MPEG 1 video files, MP3 and WAV 
music files in the Internal Flash memory or on a memory card.
You can hear the media sound from the built-in speaker on the back of the unit or 
from a headphone attached to the stereo headphone jack (diameter of the plug: 
2.5 mm).

Note:

• Be aware of the volume setting. Do not damage your ears. Tap  on the 
taskbar and adjust the slider before playback, or press the Down or Up cursor 
key.

• When using a headphone, you can hear all sounds including screentaps and 
alarms from the headphone.

• Some files (such as MP3 music files of MPEG2.5 format files) cannot be 
played back with this application.

• The Media Player application may close automatically if multiple applications 
are running simultaneously.

• The media image may be distorted and the sound may be interrupted during 
playback if other programs are running simultaneously.

• Do not insert or remove the memory card during playback.
• For detailed information on how to attach and remove the memory card, see 

the separate Start-up Guide. 
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Overview

Index screen
The Media Player application has three tabs on the Index screen: Video, Music and 
Playlist.

1. On the Applications Home screen, tap the “Media Player” application icon.
The Index screen will be displayed.

Video tab Tap to display only the video files.
Music tab Tap to display only the music files.
Playlist tab Tap to display the files registered in the Playlist.
File list area Displays the files (mpg, mpeg, mp3) which are registered 

on the Internal Flash memory and on the memory cards 
inserted into the card slots.

Play button Tap to play the file selected or to play the Playlist.
“Add to playlist” 
button

Adds the selected file to the Playlist.

Up button Moves the selected file up in the Playlist.
Down button Moves the selected file down in the Playlist.
“Remove from 
playlist” button

Removes the selected file from the Playlist.

Index screen (Video/Music tab) Playlist screen

Video tab

Music tab

Size button
Media button
Title button

Play button

Remove from 
playlist button

Playlist tab

File list area

Up button 
(for Playlist)

Down button 
(for Playlist)

Add to playlist button
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Note: To find the desired file, enter the first few characters of the file name. The 
focus moves to the matching file.

Playback screens
The Playback screen varies depending on the type of file being played.

1. On the Index screen, tap the file you want to play and then tap  or press the 
OK key or press the SELECT key.

• To close the playback screen, press the Cancel key.

Title button Tap to sort files by title.
Media button Tap to sort files by storage media (Internal Flash, CF, SD).
Size button Tap to sort files by size.
File menu

Play Plays the file in the Video, Music, or Playlist Index screen.
Info Displays the file information.
Add to playlist Adds the selected file to the Playlist.
Up Moves the selected file up in the Playlist.
Down Moves the selected file down in the Playlist.
Remove from 
playlist

Removes the selected file from the Playlist.

View menu (used to play video files)
Fullscreen Switches the screen mode from normal screen to full 

screen.
Scale Enlarges or minimizes the image (to fit the screen).

Option menu
Repeat Repeats playback of the file in the Video, Music, or Playlist 

Index screen.
Random Plays files in the Playlist at random.
Continuous 
Play

Plays files continuously starting with the highlighted file to 
the bottom of the list.

Refresh List Updates the file names modified with other applications.
Auto Refresh When turned on, updates the file names on the Index 

screen every time you insert/remove memory cards
(When turned on, it may take some time until file names 
appear if the memory card has a large number of files).

Help Displays online help.
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For video files

• If you tap on the screen, the display returns to the Index screen.  

Note: The playback time and the playback locator will be displayed in the 
normal mode only.

Press the Left 
cursor key

When pressed after a file plays more than 2 seconds, the 
current file will be played again from the beginning. When 
pressed within 2 seconds, the previous file will start playback.
When only one file or the first file in the list is being played in 
the non-repeating mode, the playback stops and returns to 
the Index screen.

Press the Right 
cursor key

Moves to the next file.
When only one file or the last file in the list is being played in 
the non-repeating mode, the playback stops and returns to 
the Index screen.

Press the Up 
cursor key

Press and hold to turn the volume up.

Press the Down 
cursor key

Press and hold to turn the volume down.

Normal mode Full screen mode

Playback  
locator

Current
playback
time/total

playback time
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For music files

Playback Control

Note: The volume control in the Media Player application also affects the 
volume setting of the entire Zaurus.

(Play) Plays the current file from the top or resumes playback if 
paused. When tapped during playback, restarts playback 
from the top of the current file.

(Stop) Stops playback.
(Pause) Pauses playback.

Tap again to resume the playback.
(Open) Stops playback, and returns to the Index screen.
(Repeat) Switches the playback mode (Repeat or Play once: non-

repeating). 
If you have selected the Repeat mode from the Option menu 
on the Index screen, this button will already have been 
pressed.

(Previous)
(Press the Left 
cursor key)

When tapped (pressed) after a file plays more than 
2 seconds, the current file will be played again from the 
beginning. When tapped (pressed) within 2 seconds, the 
previous file will start playback.
When only one file or the first file in the list is being played in 
the non-repeating mode, the playback stops and returns to 
the Index screen.

(Next)
(Press the Right 
cursor key)

Moves to the next file if the music file is being played.
When only one file or the last file in the list is being played in 
the non-repeating mode, the playback stops and returns to 
the Index screen.

(Volume Up)
(Press the Up 
cursor key)

Tap and hold to turn the volume up.

(Volume Down)
(Press the Down 
cursor key)

Tap and hold to turn the volume down.

Playback control buttons

Current playback time/
Total playback time

File information
File name,
artist name,
sampling rate, etc.

Tap to turn off the 
display to be power-
thrifty during 
playback. Press the 
Cancel key to turn 
the display on.
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Playing a file

Before playing files, insert the memory card that contains the music or video file into 
the appropriate card slot of the Zaurus, or copy the audio files to the Internal Flash 
folder of the Zaurus using the Zaurus File Transfer application.

To start playback
1. On the Index screen, tap the Video or Music tab.

All files stored in the Zaurus and memory card will be displayed according to the 
file type to be played.

2. Tap the desired file in the list.
And then tap  or press the OK key or the SELECT key.
The selected file will be played.
The playback screen varies according to the file type to be played. 

To stop playback
1. Press the Cancel key. 

The playback will be stopped and the screen will return to the Index screen.

Setting the Repeat mode
1. On the Index screen, tap the “Option” menu and then tap “Repeat”.

In the Repeat mode, the file will be played repeatedly. The files in the Playlist 
will be all played repeatedly.
To cancel the Repeat mode, repeat step 1.

Playing a file in the Playlist

By adding the video or music files in the Playlist, you can play them in the listed order 
or in random sequence. 

Adding files to the Playlist
1. On the Index screen, tap the Video or Music tab.

All files stored in the Zaurus and memory card will be displayed according to the 
file type to be played.

2. Tap the desired file in the list.
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3. Tap the “Add to playlist” button ( ). 
Or tap the “File” menu and then tap “Add to playlist”.
The selected file will be added to the Playlist with the same file name.
Tapping the Playlist tab allows you to confirm that the selection was added.

4. To add multiple files, repeat steps 1 through 3 above. 

Arranging the file order in the Playlist
Once you have added files in the Playlist, you can change the file order (playback 
order).

1. Tap the Playlist tab.
2. Tap the file you want to move.
3. Tap  or .

The selected file will move up or down. 

Deleting files from the Playlist
1. Tap the Playlist tab.
2. Tap the file you want to delete.
3. Tap the “Remove from playlist” button ( ). 

Or tap the “File” menu and then tap “Remove from playlist”.
The selected file will be deleted from the Playlist immediately.

To playback files in the Playlist tab
1. Tap the Playlist tab.

Select the file you want to play first, if necessary.
2. Tap  or press the OK key.

Files in the Playlist will be played starting with the highlighted file. Playback will 
stop at the bottom of the list.

Note: If the Repeat mode is selected in the Option menu, all files in the Playlist 
will be played continuously.

To stop playback
1. Press the Cancel key. 

The playback will be stopped and the Playlist screen will be displayed.
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To playback at random
1. Tap the Playlist tab.
2. Tap the “Option” menu and then tap “Random”.

All files in the Playlist will be played at random. 
To cancel the Random mode, repeat step 2.

Other functions

Displaying the file information
1. Tap the “File” menu and then tap “Info…”.

The file information screen will be displayed.
• When video files are selected, the following will be displayed:

Picture size, Frame rate, etc.
• When music files are selected, the following will be displayed:

Sampling rate, Channel, etc.
2. Tap  or  to close the screen.

Note: You can extend the use of MP3 playback using the “Display off” mode 
(see the “Disp OFF” button on the screen on page 59).
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Opera Browser
The Opera Browser application allows you to browse the Internet.
To browse the Internet, you must set up the communication method (modem card, 
LAN card, etc.) and network preferences (For connection method, see page 167).

Note:

• Exiting the application clears the cache without saving it.
• Elements of some Web pages (such as fonts, etc.) may not be displayed 

correctly in this application.
• Some large graphics may not be displayed in this application.
• This application may take time to open files (pdf files, etc.) which includes 

many graphics or images.
• You can check incoming e-mail messages while browsing Web pages.

Overview

Browsing screen
1. On the Applications Home screen, tap the “Opera Browser” application icon.

Back icon

 : Reload icon
 : Stop icon

Forward icon

Security Status icon
Scale page icon

Windows icon

Bookmarks icon

Help icon

Go to page icon

Menu icon

Switch layout icon
: normal

: small

Find icon
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Security Status icon Displays security information. If the page you access uses 
the SSL protocol, etc., the Security Status icon will change to 
the locked state at a set security level. Tap the icon to display 
the security level description.

Menu icon Displays the Main menu. From this menu you can access the  
main functions of the Opera Browser.

Back icon Returns to the previous page. Tap and hold to display the 
address list of the recently displayed pages and then tap the 
desired address to display the page. To close the list, tap the 
icon again.

Reload icon 

(Stop icon )

Displays the latest update of the page. When the page data 
is being downloaded, the Stop icon is displayed. 
Tap the Stop icon to stop downloading.

Forward icon Displays the next page of a series of pages you have already 
displayed. Tap and hold to display the address list displayed 
after the current page. To close the list, tap the icon again.

Go to page icon Displays a screen for entering a URL or searching for a Web 
page. To close the screen, tap the icon again.

Bookmarks icon Displays the Bookmarks screen to access and manage the 
bookmarks. To close the screen, tap the icon again.

Find icon Tap and hold to display a Find screen for searching for a 
word or a phrase included in the current page. To search for 
next, tap the “Find” icon.

Windows icon If multiple windows are open, tap to switch open windows. 
Tap and hold the icon to display the window management 
screen. To close the screen, tap the icon again.

Switch layout icon  
 

Tap to switch two types of page layout: normal and small. 
The selected type reflects the icon.

Scale page icon Scales the page up and down. Tap to switch the scale 
between 100% and the value specified on the Scale page. 
Tap and hold the icon to display the Scale page. The Scale 
page closes after you select the desired value. 

Help icon Displays online help. Tap  to close.

Main menu [M]
Open local file Displays a file list stored in the Zaurus or on a memory card. 

Tap a file to open it using the Opera Browser.
Navigation

Back [Z] Returns to the previous page.
Back History 
[H]

Displays the list of the pages displayed before the current 
page. Tap the desired page to display.
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Reload [R] Displays the latest update of the page.
Forward [X] Displays the next page of a series of pages you have already 

displayed.
Forward 
History [N]

Displays the list of the pages displayed after the current 
page. Tap the desired page to display.

Go to page 
[G]

Displays a screen for entering a URL or searching for a Web 
page.

Search the 
web

Displays a screen for entering a URL or searching for a Web 
page.

Bookmarks 
[B]

Displays the Bookmarks screen to access and manage the 
bookmarks.

Home Returns to the homepage set in the Preferences screen.
Find in page [F] Displays a Find screen for searching for a word or a phrase 

included in the current page.
Find next Searches for the same word or phrase again.
Windows [W]

Window list Displays the window management screen.
Switch to 
next

If multiple windows are open, switches open windows. When 
only one window is open, displays the window management 
screen.

New window Opens a new empty window on the current open window.
Save current Saves the current page in the Zaurus or on the memory card. 

To open the page, use the “Open local file” menu. 
Full screen 
[shift+return]

Displays the current page in full screen. To return to the  
normal screen, press Shift+Return on the hardware 
keyboard.

Close 
current

Closes the current page.

Close others Closes all pages other than the current active page.
Close all Closes all open pages.

Viewing
Full screen 
[shift+return]

Displays the current page in full screen. To return to the  
normal screen, press Shift+Return on the hardware 
keyboard.

Toggle small 
screen 
layout [L]

Switches the screen layout between normal and small (See 
page 75).

Scale page 
[S]

Displays the Scale page to scale the page up and down.

Toggle 
scaling

Switches the screen layout between normal and the size 
specified on the Scale page screen.
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Browsing Internet pages
1. Perform steps 1 to 2 in “Connecting to /disconnecting from the Network” (see 

page 196) to establish the connection to the network.

2. On the Applications Home screen, tap the “Opera Browser” application icon.
The Opera Browser opens to display the Browsing Home screen.

While the application is receiving the data, the elapsed time, etc. is displayed 
under the menu bar and the Stop icon ( ) is displayed instead of the Reload 
icon ( ).

Preferences [P]
General Displays the screen for setting up the General preferences 

(homepage address, etc.).
Security Displays the screen for setting up the Security preferences 

(cookies, etc.).
File types Displays the screen for setting up the preferences for file 

types (MIME, etc.).
Help Displays online help. Tap  to close.
Exit Exits the Opera Browser application.
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Saving Web Contents
1. Tap and hold an image on the page to initiate a pop up menu.
2. Save or open the image, copy the image URL, etc, by selecting the menu 

command in the menu.
Tap and hold a link to pop up the link context menu, allowing you to save the 
link’s context directly to a file, etc., by selecting the menu command in the menu.

Opening the specified Web page

1. Tap the Go to page icon ( ).
The Go to page screen will be displayed.
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2. Enter the desired Web page address.
3. Tap “Go to page”.

The specified Web page will be displayed.

Note:

• Entering “www” or “.com” in the Web page address field can be omitted. 
• To display the Web page on a new window, tap “New window” in step 3. 

Using the Web Search function

Search allows you to find information using the search engine you select. 

1. Tap the Go to page icon ( ).
The Go to page screen will be displayed.

2. Tap the Search engine drop-down list button and then tap the desired search 
engine.

3. Enter the information you want to search for in the Search field.
4. Tap “Search” or press the OK key.

The search result will be displayed.

Search field
Search engine drop-down 
list button
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Using bookmarks

1. Tap the Bookmarks icon ( ). 
The Bookmarks screen will be displayed. 

Registering the Web page address in the bookmark list
1. Display the Web page you want to register in the bookmark list.
2. Tap the Bookmarks icon ( ).
3. On the Bookmarks screen, tap “Add current page”.

Go radio button Displays the page selected in the bookmark list.
Del radio button Deletes the bookmark selected in the bookmark list.
Edit radio button Displays the Edit Bookmark screen.
Move radio button Allows you to change the order by dragging the item in the 

Bookmark list.
Bookmark list Lists all the addresses you have registered (bookmarked).
Add current page 
button

Tap to register the Web page address currently displayed in 
the bookmark list.

New folder button Tap to create a new folder in the bookmark list.

Go radio button

Del radio button
Edit radio button

Bookmark list
Move radio button

Add current page button New folder button
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The Edit bookmark screen will be displayed. 

Web page address field will contain the address of the latest successfully 
loaded Web page.

4. Modify the bookmark title and Web page address, etc. and then tap “OK”. 
The registered Web page will be added to the bookmark list.

Displaying the bookmarked page using bookmarks
1. On the Bookmarks screen, tap the “Go” radio button and tap the desired 

bookmark.
The selected Web page will be displayed.

Deleting bookmarks
1. On the Bookmarks screen, tap the “Del” radio button and then tap the desired 

bookmark.
A confirmation message appears.

2. Tap “Yes” to delete the bookmark.

Editing bookmarks
1. On the Bookmarks screen, tap the “Edit” radio button and then tap the bookmark 

you want to edit.
The Edit bookmark screen will be displayed. 

2. Make the necessary edits and then tap “OK” to save the modification(s).
If you tap “Cancel”, the modification is canceled. 
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Changing the bookmark order
1. On the Bookmarks screen, tap the “Move” radio button.
2. Drag the selected bookmark up or down the Bookmark list to the desired 

position.

Creating a new folder in the bookmark list

1. On the Bookmarks screen, tap “New folder”.
The Edit folder screen appears.

2. Enter the folder title, etc.
3. Tap “OK” to save.

A new folder appears in the bookmark list. 

To open the folder, tap the “Go” radio button and then tap the folder. Tap it again 
to close.

Note: To register or move bookmarks in the folder, leave the folder open.

Saving the current page and viewing it offline

1. Open the page you want to save.
2. Tap the “Menu” icon and then tap “Windows” to select “Window list”.

Or tap and hold the “Windows” icon.

The Window list screen will appear.

Windows icon
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3. On the Window list screen, tap “Save current”.
The screen for entering the destination and file name appears.

The “Save to” field displays the default file name. 

4. If desired, modify the file name and then tap the “Storage” drop-down list button 
to change the destination. 

5. Tap “OK” to save the current page.
6. Tap the Connection status icon ( ) on the taskbar and disconnect the line.
7. Tap the “Menu” icon and then tap “Open local file”.

The screen that lists the saved page file will be displayed.

8. Tap the desired file name.
The file will be displayed.

Note: The pages will be saved in the Internal Flash memory (or memory card). 
You can duplicate and delete the file from the Files Home screen.

Managing the window

In Opera Browser, you may open multiple windows at the same time, although you 
can only view one active window at a time. The Window list screen helps you to 
manage open windows.

1. Tap the “Menu” icon and then tap “Windows” to select “Window list”.
Or tap and hold the “Windows” icon.
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The Window list screen appears.

Opening a new empty window
1. On the Window list screen, tap “New window”.

A new empty window will be opened in a new open window.

Note: To open a new window by specifying the Web page address, tap the “Go 
to page” icon and specify the Web address (see page 67).

Switching open windows
1. Tap the Web page name on the Window list screen.

The selected window appears on the current screen.

Note: By tapping the Windows icon  on the Menu bar the active window will 
be switched.

Saving the current page
1. On the Window list screen, tap “Save current”.

The screen for entering the destination and file name appears.

The “Save to” field has the default file name.

2. If desired, modify the file name and then tap the “Storage” drop-down list button 
to change the destination.

3. Tap “OK” to save the current page.

Note: You can display the saved page offline. For details see page 71.

Window list showing all open 
windows.
The window you tap will be placed 
on the top and become  active.
Function buttons

These functions can also be 
carried out from the 
“Windows” menu 
commands in the “Menu” 
(see page 65).

Windows icon
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Displaying the current window on the full screen
1. On the Window list screen, tap “Full screen”.

The current window will be displayed in the full screen. 

Note:

• To return to the normal screen, press Shift ( ) + Return ( ) on the 
hardware keyboard.

• You can tap the “Menu” icon and then tap “Viewing” to select “Full screen” to 
display the window in full screen.

Closing window(s)
1. On the Window list screen, tap the desired Close button (Close current, Close 

others, Close all).
The selected window(s) will be closed.

Magnifying or reducing the page

1. Tap the “Menu” icon and then tap “Viewing” to select “Scale page”.
Or tap and hold the “Scale page” icon.

The Scale page screen appears.

2. Adjust the slide bar with a stylus or select the value by tapping the upper right 
button.
The page will be magnified or reduced.

Scale page icon
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Switching the scaling of the page
1. Tap the “Menu” icon and then tap “Viewing” to select “Toggle scaling”.

Or tap the “Scale page” icon.

The page view switches between 100% and the selected scaled value.

Repeating step 1 toggles the page view. 

Switching the Screen layout

Opera Browser has two types of layout: Traditional (normal screen) layout and 
Content column (small screen) layout. Traditional layout looks like a normal Web 
page on a PC and the Content column layout is designed for a small display and for 
more optimized connection.

1. Tap the “Menu” icon and then tap “Viewing” to select “Toggle small screen 
layout”.
Or tap the “Switch layout” icon (  or ).

The page layout switches between normal and small.

Repeating step 1 toggles the page layout. 

Note: The “Switch layout” icon on the Menu bar switches its design for the 
selected layout.

Searching for a word or phrase on the 
current page

You can search for a word or a phrase in the current open page. If the selection is 
found, it will be highlighted.

1. Tap the “Menu” icon and then tap “Find in page”.
Or tap and hold the “Find” icon.
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The Find screen appears.

2. Enter the keyword in the keyword field.
Place the checkmark on the desired Find option.

3. Tap “Find” to start searching.
If the selection is found, it will be highlighted. 

Tap the “Find” icon (or tap the “Menu” icon and then tap “Find next“) to find the 
next occurrence.

Keyword field
Enter here the keyword.

Find icon
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Setting the Opera Browser

Setting the General preferences
1. Tap the “Menu” icon and then tap “Preferences” to select “General”.

The General preferences screen appears. 

2. Select or enter the necessary items.

Home page 
address

Enter the address of the homepage you want to open when 
you launch the Opera Browser.
Tapping “Current” registers the current page as the 
homepage.

Default layout 
mode

Select how the Web page is displayed. Select the type of 
layout and whether or not the page shows the embedded 
images or not (Traditional - no images, Content column - no 
images).
Traditional layout looks like a normal Web page on a PC. 
Content column layout is simply designed for a small display. 
Tapping the Switch layout icon on the Menu bar (  or ) 
also switches these layout modes.

Popup windows Select to either accept or refuse popup windows, or to open 
them in the background. Popups opened in the background 
will be added to the window list.

Scrolling mode Select the default to either “Grab and move” (the page will 
move with the stylus), or “Scroll with selection” (the page 
scrolls in the opposite direction when the stylus moves off the 
page edge).

Hide scrollbars When checked, hides scrollbars to increase the viewing area.

OK button
Tap here to save the 
settings and close 
the screen.

Apply button
Tap here to save the 
settings but leave the 
screen open.

Reset button
Tap here to cancel the 
settings before saving.

Tap here to go to the 
previous screen (Filetype 
preferences screen).

Tap here to go to the next 
screen (Security 
preferences screen).
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Notes on the Popup window
When “Accept popup windows” is selected, a full screen popup window will open on 
the Web page.
The following popup control dialog box also will be displayed in the popup window. 

The popup control dialog box will close after a few seconds, without tapping any 
buttons. The popup windows can be closed from the window list later.

3. Tap “Apply” to save the settings. 
If you tap “Reset” instead, the settings are canceled. 

4. Tap “OK” to close the General preferences screen.

Note: Once you tap the “Apply” and “Reset” buttons, they will be dimmed. 

Setting the Security preferences
The Security preferences screen manages your certifications and security protocols 
for accessing the Web pages on the Internet. Opera Browser also issues security 
warning messages. You do not need to change the default settings unless you are 
an advanced user with special needs and technical understanding for security 
settings.

1. Tap the “Menu” icon and then tap “Preferences” to select “Security”.
The Security preferences screen appears.

OK Tap to accept the popup window.
Hide Tap to keep the popup window in the background. The popup window 

is added to the window list. 
Discard Tap to close the popup window. 
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2. Enter and select the necessary items. 

•SSL: Security Socket Layer is a protocol that is used to communicate over the 
encrypted connection, and to authenticate none, one or both of the 
participants.

•TLS: Transport Layer Security is successor of SSL, and offers up to 128 bit 
encryption. The actual strength of the encryption varies depending on the 
Web site. 

3. Tap “Apply” to save the settings. 
If you tap “Reset” instead, the settings are canceled. 

4. Tap “OK” to close the Security preferences screen.

Note: Once you tap the “Apply” and “Reset” buttons, they will be dimmed. 

Accept cookies When checked, only the information you entered or 
selected on the Web page will be saved. The cookie will 
be sent back the next time when the Zaurus browses the 
same Web page.

Enable javascript Tap to activate the Javascript. (ECMAScript)
Issue security 
warnings 

Tap to display a warning message when you move 
between the safe and unsafe Web site.

Enable SSL v2 Tap to enable the SSL v2 option.
Enable SSL v3 Tap to enable the SSL v3 option.
Enable TLS 1.0 Tap to enable the TLS 1.0 option.
Certificates

Personal/
Authorities

Personal certificates are used to identify you as the 
genuine user of your secure Web services, while 
certificate authorities are used to certify a Web service as 
secure for you to use. Most certificate authorities you will 
ever need are pre-installed with Opera Browser, and 
personal certificates are automatically installed when 
required by a secure Web site. These settings are here 
should you want to delete or fine-tune your certificates. To 
view the list of personal certificates, tap “Personal...”. To 
view the list of authorities, tap “Authorities...”. Tap “Import” 
to import a certificate from a local file. Tap “Export” to 
export to a local file. Tap “OK” to save the settings.

Password
Set password Register the password to use the certificate options. The 

password prevents the certificate you set up from 
unauthorized use.
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Setting the Filetype preferences
Opera Browser directly handles certain files, such as Web page documents. Others 
are passed on to plug-ins and external applications, or just saved on your PC. The 
Filetype preferences let you control Opera Browser's behavior when it encounters 
different file types.

1. Tap the “Menu” icon and then tap “Preferences” to select “File types”.
The Filetype preferences screen appears. 

2. Select or enter the necessary items.

MIME types Select or enter the MIME type you want to assign an  
action to. 

New MIME type Adds a new MIME type to the drop-down list.
Delete MIME type Deletes a MIME type from the drop-down list.
File extensions Enter the file extension associated with the MIME type. 

You can specify multiple extensions by inserting a 
comma. (example: jpeg, jpg, jpe) 
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3. Tap “Apply” to save the settings. 
If you tap “Reset” instead, the settings are canceled. 

4. Tap “OK” to close the Filetype preferences screen.

Note: Once you tap the “Apply” and “Reset” buttons, they will be dimmed. 

Action
 

Tap the drop-down list to select how Opera Browser 
operates when you click on the links embedded in the 
page.

Open in browser Opens the file using Opera Browser. Opera Browser can 
display text, certain markup languages, images and video 
formats.
Be sure that Opera Browser can display a certain file type 
before choosing this setting.

Ask for file 
name

Opera Browser asks you to enter a name and save the 
page to the Zaurus.

Automatic 
download

Opera Browser downloads and saves the page to the 
Zaurus with its original file name.

Open with other 
application

Opera Browser asks you to choose the application to use  
to view the file.

Open with 
plugin

Opera Browser asks you to choose the plugin type you 
want to use to view the file. Use the default setting for 
normal use.
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Keyboard shortcuts

Use the following single key or combination key shortcuts from the hardware 
keyboard:

Shift+ cursor: Scrolls pages to one of the indicated directions.
Shift+Return: Toggles view mode between normal and full screen.
M: Pops up the main menu.
Z: Goes to the page viewed before the current page.
X: Goes to the page viewed after the current page.
H: Displays the list of the pages displayed before the current page.
N: Displays the list of the pages displayed after the current page.
G: Displays the Go to page screen.
B: Displays the Bookmarks screen.
F: Displays the Find screen.
W: Displays the Window list screen.
S: Displays the Scale page screen.
L: Switches the layout mode between normal and small.
P: Displays the Preferences (General) screen.
A: Focuses the next link in the current page.
Q: Focuses the previous link in the current page.
R: Displays the latest update of the page.
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EMail

Overview

The EMail application allows you to send and receive e-mail messages and 
features:
• POP3/POP3(APOP)/IMAP4/SMTP protocols
• Multiple e-mail accounts
• Converts attachment files using the MIME format
• The Mail light (Email LED) flashes for an e-mail receipt
• Refers to the Address Book application to import e-mail addresses, and registers 

the e-mail addresses of the e-mail you received in the Address Book application.
• Searches for received e-mail messages
• Groups received e-mail messages by mailboxes
• When sending or receiving e-mail messages offline, the pop-up screen for the 

network connection will be displayed. The line is terminated automatically when 
the task is completed. When sending or receiving e-mail messages online, the 
line will not be terminated upon completion.

To send and receive e-mail messages, you must:
• Set up the communication method (modem card, LAN card) and network 

preferences
• Set up an e-mail account in the EMail application

Caution! Be sure to check that enough memory (text message size plus at 
least 10 KB addition) is available before exiting the EMail application 
as the EMail application needs to save the data being edited.

Note:

• One e-mail message has a total memory capacity of approximately 2MB for 
attached files (The total memory for one e-mail message including attached 
files has a MIME size of approximately 3MB).

• The EMail application may have a delayed launch depending on the quantity 
of data being saved.

• The Intellisync for Zaurus (provided on the CD-ROM) allows you to 
synchronize e-mail data stored on a PC. For details, refer to the Intellisync for 
Zaurus online manual.
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Index screen
In the Index screen of the EMail application, there is a difference in appearance 
between horizontal and vertical display as follows:

1. On the Applications Home screen, tap the “EMail” application icon.
The EMail Index screen will be displayed.

Vertical display
The EMail Index screen has six tabs in Vertical display.

Folders tab Displays the folder list.
Browses the Inbox, Outbox, Sent and Draft folders, etc. of 
each account in the tree format.

Inbox tab Displays received e-mail messages.
Unread messages are displayed in blue. Read messages are 
displayed in black. Messages that downloaded titles only are 
displayed in red.

Outbox tab Displays unsent e-mail messages in red. 

Sent tab Displays sent e-mail messages in black.

Draft tab Displays draft e-mail messages.

Deleted tab Displays deleted e-mail messages.

Inbox
Send mail icon
Get mail icon
New mail icon

Delete icon

Sort by status 
button

Storage 
switch button

Created 
account 
name

Folder list
Double-
tapping the 
folder 
displays the 
Index screen 
for the folder.

Folders

“Folders” tab

Select by 
folder button

“Inbox” tab



85 EMail
Horizontal display

Outbox Sent

Edit mail icon

“Outbox” tab

Draft

“Deleted” tab

Deleted

“Sent” tab

“Draft” tab

New mail icon
Get mail icon

Created account 
name

Storage switch 
button

Delete icon

Folder list
When the focus is in the account name in the folder list, all received 
e-mail messages in the account will be displayed in this area.

Reply/Reply to all/
Forward mail icon

Send mail icon
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Note: Synchronization folders are used for synchronization with a PC. E-mail 
messages to be synchronized only are saved in the Synchronization 
folders. If you clear “Show sync account” in the “Option” menu, these 
folders will disappear from the folder list.

Folder list Browses the Inbox, Outbox, Sent and Draft folders, etc. of 
each account in the tree format.
Tap  to display the folders in the account.
Tap  to display only the account name.

Storage switch 
button

Switches the storage between the Internal Flash memory and 
memory card to save the created or received e-mail messages.

Send mail icon Sends all unsent e-mail messages in the Outbox.
Get mail icon Receives all e-mail messages that are saved in the mail server.
New mail icon Tap to create a new e-mail message.
Reply mail icon 
(Inbox)

Tap to create a reply/forward e-mail message.

Edit mail icon 
(Outbox, Sent, 
Draft)

Tap to edit the e-mail message.

Delete icon Tap to move the e-mail message to the “Deleted” folder. 
Sort by status 
button

Tap to sort e-mail messages by All/Unread/Read.

Select by folder 
button 
(Vertical display 
only)

Tap to select folder containing e-mail messages you want to 
see.

File menu
New mail Opens a screen to create a new e-mail message.
Edit mail Opens an existing e-mail message to be edited.
Reply to mail Opens a reply mail screen for the sender only.
Reply to all Opens a reply mail screen for all senders and receivers.
Forward mail Opens a screen to forward the received e-mail message.
Folder New: Creates a new folder.

Rename: Renames the created folder.
Delete: Deletes the created folder.

Copy/Move 
mail…

Moves or duplicates e-mail messages among the Internal 
Flash memory, CF card and SD memory card.

Delete mail… Moves the e-mail message(s) to the “Deleted” folder.
Empty 
“Deleted” 
folder

Clears the “Deleted” folder.
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Mail menu
Send/Receive Sends and receives e-mail messages for all accounts.
Get mail in Receives the e-mail messages in the selected account.
Get all mail Receives all e-mail messages for all accounts that are saved 

in the mail server.
Send all mail Sends all unsent e-mail messages in the Outbox.
Cancel 
transfer

Cancels e-mail transfer.

Account… Opens a screen to set up, edit or delete an e-mail account 
(see page 91).

Option menu
Search… Searches for received e-mail messages with search 

conditions.
Font Changes the display font size.
Show 
summary

Selects whether or not to display the e-mail message in 
details on the Index screen (see page 107).

Show status Selects whether or not to display status at the bottom of the 
Index screen.

Show sync 
account

Selects whether or not to display folders for Synchronization 
on the folder list.

Move to… Moves the e-mail messages to the selected folder.
Set status Changes the e-mail status between Sent and Unsent in the 

Outbox and Sent folder, or Read and Unread in the Inbox 
folder.

Filter Creates a filter rule by folder for received e-mail messages.
Preferences… Changes how the Send mail icon and the Get mail icon 

perform, etc.
Help Displays online help.
About Displays the software version of the EMail application.
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Examine (Detail) screen
1. On the Index screen, tap an e-mail message. 

Deletion checkbox Deletes e-mail messages checked by the “Delete mail” in the 
“File” menu on the Index screen (This option does not work 
for unsent or unread messages).

Previous icon Displays the previous message.
Next icon Displays the next message.
Send mail icon 
(Outbox, Draft)

Sends the e-mail message displayed on the Examine 
screen.

Reply mail icon 
(Inbox)

Tap to create a reply/forward e-mail message.

Attachments icon Opens an Attachment list screen allowing you to open, or 
save an attachment file to an expansion memory card, etc. 
(see page 102).

E-mail message

Deletion checkbox Previous icon
Send or Reply mail icon

Attachments icon

Next icon
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2. Tap  to close the Examine screen and return to the Index screen.

Mail menu
Get this mail 
(Inbox)

Receives an e-mail message if only the message title has 
been already received.

Send this mail 
(Outbox/Draft)

Sends the e-mail message displayed on the Examine 
screen.

New mail Opens a screen to create a new e-mail message.
Edit mail Opens an existing e-mail message to be edited.
Reply to mail Opens a reply mail screen for the sender only.
Reply to all Opens a reply mail screen for all senders and receivers.
Forward mail Opens a screen to forward the received e-mail message.
Add to 
Address Book

Adds the e-mail address of the sender to the Address Book 
application.

Set status Changes the e-mail status between Sent and Unsent in the 
Outbox and Sent folder, or Unread in the Inbox folder.

Move to… Moves the e-mail messages to the selected folder.
Copy Copies the selected text to the clipboard.
Delete Deletes the e-mail message displayed on the Examine 

screen.
View menu

Previous Displays the previous message.
Next Displays the next message.
Font Changes the font size.
Attachments… Opens an Attachment list screen allowing you to open, or 

save an attachment file to an expansion memory card, etc. 
(see page 102).

Text view Changes the view format between the text format and rich 
text format.
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New mail screen
1. On the Index screen, tap .

The Special Notes screen will be displayed.
2. Tap “Yes”.

Direction drop-down 
list button

Tap to select the e-mail address direction (To, Cc, Bcc and 
From).

Address Book icon Tap to list the e-mail addresses registered in the Address 
Book application. Select the e-mail address(es) from the 
list.

Attachments icon Tap to open the screen containing the attachment files you 
wish to attach to the e-mail message.

Mail menu
Send this mail Sends the currently displayed e-mail message.
Put in Outbox Saves the created e-mail messages to the Outbox folder.
Save as Draft Saves the created e-mail messages to the Draft folder.
Refer Address 
Book

Lists the e-mail addresses registered in the Address Book 
application. Select the e-mail address(es) from the list.

Adding 
Attachments

Opens the screen containing the attachment files you wish 
to attach to the e-mail message.

Direction drop-down
list button

E-mail address field

Subject field

Address Book icon

Message area

Attachments icon
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E-mail accounts

The EMail application allows multiple e-mail accounts to be registered.

Note: If you have already registered e-mail accounts in the Network 
application, they apply to the e-mail accounts for the EMail application. 
To configure detailed settings, tap the “Account” in the “Mail” menu on 
the Index screen. Detailed procedures are described below.

Setting up an e-mail account
1. On the Index screen, tap the “Mail” menu and then tap “Account…”.

The Account settings screen will be displayed.

2. Tap “New”.
The Outgoing options screen will be displayed.

Use signature checkbox Server settings drop-
down list button

Settings button
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3. If your server needs Authentication certification, select “Authentication” and 
then tap the “settings…” button.
Make necessary changes on the Authentication Settings screen and then tap 

.
4. Tap the Incoming tab to set the receiving options.

Account name Enter the desired account name. This account title will be 
displayed on the Account settings screen.

Your name Enter your name as used in the “From” field of the 
e-mail message.

Email Enter your e-mail address.
SMTP server Enter the server name for sending e-mail messages.
SMTP port Enter the server port number for sending e-mail messages 

(default setting: 25).
Use signature 
checkbox

Select to add a personal signature. On the screen that will be 
displayed, create a signature to be added to the end of all 
new e-mail messages. Tap  to save the signature.

Server settings
Server settings 
drop-down list 
button

POP before 
SMTP

Performs POP authentication before 
sending e-mails.

Authentication Select this option if your SMTP server 
needs sending authentication.

settings button If the Authentication option is selected, tap to create settings.

Choose account type 
drop-down list button 

Skip large emails buttonDelete mail checkbox



93 EMail
5. When you have finished settings, tap  to save them.

Note:

• You can view the e-mail messages for each e-mail account even if multiple 
accounts are registered.

• When multiple e-mail accounts are registered, specify the account in which to 
create a new e-mail message by tapping the account name on the folder list 
before tapping .

Editing the e-mail account
1. On the Index screen, tap the “Mail” menu and then tap “Account…”.
2. Tap the desired account on the Account settings screen and then tap “Edit”.
3. Edit the desired items and tap  to save the modification.

Choose account type 
drop-down list button

Tap to select an account type:
POP3, POP3 (APOP), IMAP4.

Username Enter the login name used to log into an e-mail system.
Password Enter password used to log into an e-mail system.
Server Enter name of the server used to receive e-mail messages.
Port Enter server port number for receiving e-mail messages. 

(default setting··· POP3: 110, IMAP4: 143).

Server settings
Delete mail 
checkbox

Select if you want to erase e-mail messages saved in the 
server after you have finished downloading messages.

Skip large 
emails button

Tap to specify a received e-mail message size limit.
When tapped, the Email threshold screen will be displayed. 
Tap and drag the slider to specify the maximum size of 
incoming e-mail messages.
(Range: 10 KB - 3072 KB)
Tap  to save the settings.
If you attempt to receive an e-mail message that is too large, 
only the message title (sender name, date and the size of the 
message) will be downloaded.
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Deleting an e-mail account
1. On the Index screen, tap the “Mail” menu and then tap “Account…”.
2. Tap the desired account you want to delete and then tap “Delete”.

A confirmation message will be displayed.
3. Tap “Yes” to delete the account.

The selected account will be deleted.

Creating an e-mail message

1. Tap the account name of the e-mail message to be created on the folder list.

Note:

• Selecting “Synchronization” only creates an e-mail for synchronization with a 
PC. To send e-mails from your Zaurus, select e-mail accounts other than 
“Synchronization”.

• To save created e-mail messages to memory cards, insert the memory cards 
into the specified card slots. Tap the Storage switch button and select the 
desired storage before performing step 2.

2. Tap .
The New mail screen for the selected account will be displayed.

Direction drop-down list
button

E-mail address field

Subject field

Address Book icon

Message area

Attachments icon

Account name
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3. Specify the recipients.
To select e-mail addresses stored in the Address Book:
Tap the Address Book icon to display the Select recipients screen.
From the list that appears, tap the desired e-mail address and then tap “To:”, 
“Cc:” or “Bcc:”.
The selected recipient will be displayed at the top of the screen.

To manually enter an e-mail address:
Tap “Input...” on the Select recipients screen to display the Recipients screen.

Enter only one address in the field, and select “To:”, “Cc:” or “Bcc:” and tap .
The display will return to the Select recipients screen with the address shown.
To enter multiple e-mail addresses, repeat the procedure above.

When you delete the selected e-mail address:
Select the e-mail address on top of the Select recipients screen and then tap “Delete”.

Note: Tap-and-holding the recipient displayed in the upper part of the screen 
will display the pop-up menu. Selecting “Edit…” will display the 
Recipients entry screen so you may change the address destination 
between “To:”, “Cc:” and “Bcc:” or modify the address.

Tap and hold the recipient 
to display the pop-up 
menu. This menu allows 
you to edit or delete the 
recipient.
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4. After entering/selecting the e-mail address(es), tap .
The display returns to the New mail screen.

5. Enter the subject and body.
6. Tap the “Mail” menu and then tap “Send this mail”.

When you have set the automatic connection on the Network application:
The connection to the network will start automatically and then e-mail messages 
will be sent.
If you have registered several network services, the following confirmation 
screen will be displayed, and connection to the network will then start 5 seconds 
later.

Note: When a modem card is attached to the SL-6000L, a confirmation screen 
prompting you to select between the card and the internal wireless LAN 
module is displayed (see page 198).

When you have not set the automatic connection on the Network application:
Tap the network service to be connected on the confirmation screen shown 
above, and then tap “Connect” (see page 191).

To save the e-mail message and send it later:
In step 6, tap  to save the new e-mail message.
It will be saved in the Outbox of the e-mail account selected in step 1.

To save the e-mail message as a draft:
In step 6, tap the “Mail” menu and then tap “Save as Draft”.
Or tap  and then tap “Yes” on the confirmation screen that appears.
The created e-mail message will be added to the Draft folder of the e-mail 
account selected in step 1.

Note:

• You can enter the e-mail address directly in the Email address field. To add 
“Cc” or “Bcc”, tap the Direction drop-down list button and then tap “Cc:” or 
“Bcc:”. When entering multiple addresses, insert a comma between each.
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• When multiple e-mail accounts are registered to change the account for 
creating the e-mail message, tap the Direction drop-down list button and then 
tap “From”. From the drop-down list that appears in the Email address field, 
select the desired account.

• If you tap the e-mail message on the Index screen, the Examine (Detail) 
screen displays the contents of the message.

Attaching a file to the e-mail message
1. On the New/Edit mail screen, tap the Attachments icon ( ).

2. Tap a file in the Files list on the left, and then tap “Attach ->”.
The file is attached to the e-mail message you are editing when the selected file 
is listed in the Attachment list on the right.
• If you want to remove the attachment, tap it in the Attachment list and then 

tap “Remove”.

3. When file attachment is finished, tap .
The display returns to the New/Edit mail screen.

4. Tap  to save the e-mail message to the Outbox.
To send the e-mail message immediately, tap the “Mail” menu and then tap 
“Send this mail” (see page 96).

Note:

• The total memory of attachment files for one e-mail message is approximately 
2 MB.

• If you send an e-mail message including an attachment on a memory card, 
leave the card in the card slot until you have finished transferring the e-mail 
message.

File type drop-down list button
Narrow the category by 
switching the file types: 
“image”, “text”, etc.

Files list
Attachment list
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Sending e-mail messages in the Outbox

Caution! No operations are allowed during mail transfer.

Sending e-mail messages
1. Tap the Outbox icon ( ) in Horizontal display, or tap the Outbox tab ( ) in 

Vertical display.
2. On the Index screen, tap the Send mail icon ( ).

All unsent e-mail messages will be sent.
The sent e-mail messages are saved in the Sent folder.

Note:

• Tapping the “Mail” menu and then tapping “Send/Receive” or press-and-
holding the EMail key allows you to simultaneously send all e-mail messages 
in the Outbox for all e-mail accounts.

• You can select the action to be executed when you tap the Send mail icon on 
the Index screen. Depending on your selection, tapping the icon will either 
send e-mail for all e-mail accounts or send e-mail for the selected account 
only. You can perform this setting using “Preferences…” in the “Option” menu 
on the Index screen (see page 109).

Sending a single e-mail message
1. Tap the desired e-mail message in the Outbox.

The Examine screen will be displayed.
2. On the Examine screen, tap the Send mail icon ( ).

Status
Displays the number 
of unsent messages

Send mail icon

Status
: Unsent e-mail
: E-mail with no 

recipients
: E-mail with 

attachment



99 EMail
Receiving e-mail messages

Caution! No operations are allowed when receiving e-mails.

Receiving e-mail messages from all e-mail accounts
1. On the Index screen, tap the “Mail” menu and then tap “Get all mail”.

When you have set the automatic connection on the Network application:
The connection to the network will start automatically and then e-mail messages 
will be received from all the e-mail accounts.
If you have registered several network services, the following confirmation screen 
will be displayed, and connection to the network will then start 5 seconds later.

Note: When a modem card is attached to the SL-6000L, a confirmation screen 
prompting you to select between the card and the internal wireless LAN 
module is displayed (see page 198).

When you have not set the automatic connection on the Network application:
Tap the network service to be connected on the confirmation screen shown 
above, and then tap “Connect” (see page 191).

The received e-mail messages will be displayed on the Inbox Index screen.

Status
:Unread e-mail
:Read e-mail
:E-mail with 
attachment

: E-mail title having no 
message downloaded 
(unread)

: E-mail title having no 
message downloaded 
(read)

Storage switch button

Get mail icon
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Receiving e-mail messages from one e-mail account
1. On the Index screen, tap the “Mail” menu and then tap “Get mail in”.
2. Tap the desired account in the submenu.

Note:

• When you have received the e-mail message(s), the Mail light (Email LED) of 
the unit will flash green.

• Tapping the “Mail” menu and then tapping “Send/Receive” or pressing and 
holding the EMail key allows you to simultaneously receive e-mail messages 
from all e-mail accounts.

• Tapping the Get mail icon ( ) instead of following step 1 allows you to 
receive e-mail messages. If you have set the Get mail icon for “Get all mail”, 
you will receive e-mail messages for all the accounts. If you have set the Get 
mail icon for “Get mail”, you will receive e-mail messages only for the selected 
accounts. You can perform this setting using “Preferences…” in the “Option” 
menu on the Index screen (see page 109).

• If you receive an e-mail message of a size larger than specified, or the 
connection is terminated, only the message title (sender name, date, and the 
size of the message) will be downloaded. For information on maximum size 
settings, see page 93.

• When you choose the account type IMAP4 (in the Incoming tab in the account 
setting), only the message title may be downloaded regardless of the specified 
incoming e-mail message size (see page 92).

• To save received e-mail messages to memory cards, insert the memory cards 
into the specified card slots. Tap the Storage switch button before performing 
step 1 and select the desired storage.

• Please wait until all e-mail messages are displayed before exiting the EMail 
application.

Downloading e-mail messages by message title
1. Tap the Inbox icon ( ) in Horizontal display, or tap the Inbox tab ( ) in 

Vertical display.
2. On the Index screen, tap the message title of the e-mail message you want to 

receive.
The Examine screen of the received e-mail message will be displayed.

3. Tap the “Mail” menu and then tap “Get this Mail”. The e-mail message will be 
downloaded and then displayed on the Examine screen.
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Sending and Receiving e-mail messages simultaneously
1. On the Index screen, tap the “Mail” menu and then tap “Send/Receive”.

Or press and hold the EMail key on the keyboard.
All e-mail messages will be sent and received simultaneously from all e-mail 
accounts.

Note: By pressing and holding the EMail key, you can send and receive e-mail 
messages even while you are running another application.

Opening an e-mail message

1. Tap the Inbox tab ( ) in Vertical display, or tap the Inbox icon ( ) in 
Horizontal display.
E-mail messages in the Inbox will be displayed.

2. If necessary, tap the Storage switch button to select the desired storage.

Note:

• You can select folders by tapping the Select by folder button (in the Vertical 
display only), and select e-mail messages by tapping the Select by status 
button (All, Unread, or Read).

• You can sort e-mail messages by tapping each column button.

Storage switch 
button
Select by status 
button

Column buttons

Vertical display

Select by 
folder button

Horizontal display
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3. Tap the desired e-mail.
The Examine screen of the received e-mail message will be displayed.

4. Tap  to close the Examine screen.

Note: For read and sent e-mail messages:
If the Deletion checkbox is selected, you can delete them at a time from 
the “Delete mail…” in the “File” menu of the Index screen (see page 
105).

The checked e-mail messages will be displayed in gray in the Inbox/Sent 
folder. You cannot select the Deletion checkbox to delete unread or 
unsent e-mail messages.

Opening or arranging attachments

1. Tap the received e-mail message including the attachment.
The Examine screen will be displayed.

2. Tap the Attachments icon ( ).
The Attachment list screen will be displayed.

Deletion checkbox

Attachment list
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3. Select the attached file you want to open.
4. Tap any of the following button to execute.

5. Tap  to return to the Examine screen.

Note:

• If the “Open a file in the Attachment screen” checkbox is selected on the 
Preferences screen that appears by selecting “Preferences…” from the 
“Option” menu, the “Open” button is displayed. If the checkbox is not selected, 
the “Save and open” button is displayed.

• The memory cards are not case-sensitive to file names. Files such as 
“ABC.txt” and “aBC.txt” attached to the same e-mail will be treated as the 
same file when received. The contents of the first file will be overwritten with 
the second one.

Replying/Forwarding to an e-mail message
1. On the Index screen, move the focus to the desired e-mail message you want 

to reply or forward.
Or open the Examine screen of the e-mail message you want to reply or 
forward.

2. Tap the desired command from the following:
Replying to only to the sender(s)

Tap the “File” menu and then tap “Reply to mail”.
Or tap the Reply mail icon ( ) and then tap “Reply”.

Replying to all recipients and senders
Tap the “File” menu and then tap “Reply to all”.
Or tap the Reply mail icon ( ) and then tap “Reply to all”.

Forwarding an e-mail message
Tap the “File” menu and then tap “Forward mail”.

Open/Save and open Open : Opens the attachment with a specified application.
Save and open : Saves the attachment to the Internal 
Flash memory or memory card, and then opens it with a 
specified application.

Save button Saves the selected attachment(s) to the Internal Flash 
memory or memory card.

Save all button Saves all attachments to the Internal Flash memory or 
memory card.

Delete button Deletes the attachment while leaving the original e-mail 
message.
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Or tap the Reply mail icon ( ) and then tap “Forward”.
3. Enter the message and direction, etc.
4. Tap  to save it in the Outbox or tap the “Mail” menu and then tap 

“Send this mail” to send.

Editing an e-mail message

1. On the Index screen of the Outbox or Draft folder, move the focus to the desired 
e-mail message you want to edit.

2. Tap  and edit the message.
3. Tap  to save it.

Note:

• On the Examine screen, tap the “Mail” menu and then tap “Edit mail” instead 
of performing steps 1 and 2.

• Sent e-mail messages in the Sent folder will be saved as unsent messages in 
the Outbox, if they are edited and saved.

Deleting e-mail messages

Deleted e-mail messages will be moved to the “Deleted” folder. For details on how 
to delete them in the “Deleted” folder, see page 106, “Clearing the “Deleted” folder”.

Deleting an e-mail message
1. On the Index screen, move the focus to the e-mail message you want to delete.
2. Tap .
3. Tap the drop-down list button and then tap “This mail”.
4. Tap “Yes”.

The selected e-mail message will be moved to the “Deleted” folder.

Note: Or on the Examine screen, tap  and then tap “Yes” on the confirmation 
screen.

Deleting read e-mail messages
1. Tap  on the Index screen of the Inbox folder.
2. Tap the drop-down list button and then tap “Read mail”.
3. Tap “Yes”.

The read e-mail messages will be moved to the “Deleted” folder.
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Deleting selected e-mail messages
You can delete read and sent e-mail messages by selecting the Deletion checkbox 
(see page 102). The checked e-mail messages will be displayed in gray on the Index 
screen. You cannot select the Deletion checkbox to delete unread or unsent e-mail 
messages.

1. On the Index screen, tap .
2. Tap the drop-down list button and then tap “Selected mail”.
3. Tap “Yes”.

The selected e-mail messages will be moved to the “Deleted” folder.

Deleting all e-mail messages in the folder (Inbox folder, 
Sent folder, etc.)
1. On the folder list, tap the folder including e-mail messages you want to delete.
2. If necessary, tap the Storage switch button to select the storage.
3. Tap .
4. Tap the drop-down list button and then tap “All mail”.
5. Tap “Yes”.

All e-mail messages in the selected folder will be moved to the “Deleted” folder.

Note: If you select “Read” or “Unread” using the Sort by status button in the 
Inbox folder before tapping  in step 3, only the selected read or unread 
messages will be deleted.

Deleting all received e-mail messages in the account
1. Tap the account name you want to delete received e-mail messages on the 

folder list.
2. Tap .
3. When the Zaurus is in Horizontal display, tap the drop-down list button and then 

tap “All mail in this account”.
4. Tap “Yes”.

All received e-mail messages in the account will be moved to the “Deleted” 
folder.

Note: Follow the next steps to retrieve e-mail messages.

1. On the Index screen of the “Deleted” folder, move the focus to the e-mail 
message you want to move.

2. Tap the “Option” menu and then tap “Move to…”.
The Folder select screen will be displayed.
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3. Tap the folder to which you want to move the e-mail message.
The selected e-mail message will be moved to that folder.
• Instead of performing step 2, tap-and-holding the e-mail message will allow 

you to use a pop-up menu.

Clearing the “Deleted” folder
1. Tap the “File” menu and then tap “Empty “Deleted” folder”.

A confirmation screen will be displayed.
2. Tap “Yes” to clear the “Deleted” folder.

Note:

• If the “Empty “Deleted” folder on exit” checkbox is selected on the Preferences 
screen, closing the Email application clears the “Deleted” folder.

• On the Index screen of the “Deleted” folder, tapping  and selecting “All mail” 
also clears “Deleted” folder.

Registering the e-mail address of the sender 
in the Address Book application

You can register the e-mail address of the sender in the Address Book application.

1. Open the Examine screen that includes the e-mail addresses you want to 
register in the Address Book application.

2. Tap the “Mail” menu and then tap “Add to Address Book”.
The Add to Address Book screen will be displayed.

3. Tap the drop-down list button and then tap the e-mail address you want to add 
to the Address Book application.

4. Tap .
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The selected e-mail address will be registered to the Address Book application 
and the display turns to the Index screen of the Address Book application. 
Editing can be done at this time.

Changing the view pattern

Displaying the e-mail message on the Index screen
On the Index screen, you can display each e-mail message.

1. On the Index screen, tap the “Option” menu and then tap “Show summary”.
The lower half of the screen displays the selected message.
To return to the original view pattern, repeat step 1.

Hiding the Status
1. On the Index screen, tap the “Option” menu and then tap “Show status”.

When the menu is cleared, the status at the bottom of the Index screen 
disappears. To display it again, repeat step 1.

Hiding the Synchronization folders on the folder list
Synchronization folders are used for synchronization with a PC only. You can hide 
the Synchronization folders from the folder list.

1. On the Index screen, tap the “Option” menu and then tap “Show sync account”.
When the menu is cleared, the Synchronization folders on the folder list 
disappears. To display it again, repeat step 1 to check the menu.

Changing the view pattern of the Examine screen
You can view the e-mail message in Text or Rich text format on the Examine screen.

1. On the Examine screen, tap the “View” menu and then tap “Text view”.
The Examine screen switches between the two formats.
The Rich text format displays the attachment (image file, etc) followed by the 
message. When the e-mail message includes the e-mail address or URL 
beginning with “http://” or “https://”, the address will be displayed in blue. 
Tapping the blue characters will open the New mail screen or launch the Opera 
application.
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Changing the color of an e-mail on the Index screen
You can attach, change or remove the various color tags for each e-mail shown on 
the Index screen.

1. On the Index screen, tap and hold the e-mail you want to color.
The pop-up menu will be displayed.

2. Tap “Set color tag” and select the color from the color palette.
The background color of the selected e-mail will be changed.
To clear the color tag, tab the “Remove color tag” in step 2.

Note: If you have set filtering for incoming mail, the e-mail will be displayed in 
the selected color tag (see page 113). Use the procedure above to 
change or clear the color.

Switching the e-mail status between Read and Unread
1. On the Index screen of the Inbox folder, move the focus to the e-mail message 

you want to switch.
2. Tap the “Option” menu and tap “Set status”, then select “Read” or “Unread”.

The status switches between Read and Unread.

Note: You can also switch the e-mail status from “Read” to “Unread” on the 
Examine screen.

Switching the e-mail status between Sent and Unsent
1. On the Index screen of the Outbox or Sent folder, move the focus to the e-mail 

message you want to switch.
Or open the Examine screen of the e-mail message.

2. Tap the “Option” menu and tap “Set status”, then select “Sent” or “Unsent”.
The status switches between Sent and Unsent.

Other settings

Clearing the “Deleted” folder when the EMail application is 
closed
1. On the Index screen, tap the “Option” menu and then tap “Preferences…”.

The Preferences screen will be displayed.
2. Select the “Empty “Deleted” folder on exit” option.
3. Tap  to save the setting.



109 EMail
Preventing disconnection from the network 
after transferring e-mail messages 
(if automatic connection is set)

1. On the Index screen, tap the “Option” menu and then tap “Preferences…”.
The Preferences screen will be displayed.

2. Clear the “Hang up after send/recv when auto-connected” option.
3. Tap  to save the setting.

Setting the attachment file option

You can open attachments without saving it in your Zaurus.
Select the checkbox when you want to save the attachments first, then open it.

1. On the Index screen, tap the “Option” menu and then tap “Preferences…”.
The Preferences screen will be displayed.

2. Select the “Open a file in the Attachment screen” option.
3. Tap  to save the setting.

Note: Depending on this setting, the button name will change to “Open” or 
“Save and open”.

Changing the action of the Send mail icon 
and Get mail icon on the Index screen

You can select the action to be executed when you tap the Send mail icon ( ) or 
Get mail icon ( ) on the Index screen. Depending on your selection, tapping these 
icons will either send/receive e-mail for all e-mail accounts or send/receive e-mail for 
the selected e-mail account only.

1. On the Index screen, tap the “Option” menu and then tap “Preferences…”.
The Preferences screen will be displayed.

2. Tap the drop-down list button and then select the desired action:
“Get all mail” or “Get mail” for the Get mail icon, or “Send all mail” or “Send mail” 
for the Send mail icon.

3. Tap  to save the setting.
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Creating a new folder and organizing e-mail 
messages
You can organize e-mail messages by creating new folders.

Creating a new folder
1. Tap the account name for which you want to create a new folder on the folder 

list.

2. Tap the “File” menu and then tap “Folder”.
3. Tap “New” in the submenu.

The new folder will be created for the account and will be named as 
“New mailbox”.

4. Enter the folder name.

Note: You can create a new folder inside the created folder.

Moving an e-mail message to another folder
This function allows you to move an e-mail message to another created folder.

1. On the Index screen, move the focus to the e-mail message you want to move.
2. Tap the “Option” menu and then tap “Move to…”.

The Folder select screen will be displayed.
3. Tap the folder to which you want to move the e-mail message.

The selected e-mail message will be moved to that folder.

Note:

• Instead of performing step 2, tap-and-holding the e-mail message will allow 
you to use a pop-up menu.

• The message type (sent mail, received mail, etc.) will determine the folder to 
which you want to move the e-mail message.
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Viewing the received e-mail messages by folder
(Vertical display only)
1. On the Inbox Index screen, tap the “Select by folder” button (see page 101).

The folder(s) of Inbox will be displayed.
2. Tap the folder you want to display.

The e-mail messages in the selected folder will be displayed.

Renaming a folder
You can rename a created folder.

1. Tap the desired folder to be renamed on the folder list.
2. Tap the “File” menu and then tap “Folder”.
3. Tap “Rename” in the submenu.
4. Modify the folder name.

Deleting a folder
You can delete a created folder.

1. Tap the desired folder to be deleted on the folder list.
2. Tap the “File” menu and then tap “Folder”.
3. Tap “Delete” in the submenu.

A confirmation message will be displayed before the folder is deleted.
4. Tap “Yes” to delete the folder.

The selected folder will be deleted. E-mail messages in the deleted folder will 
be moved to the “Deleted” folder.

Note: The default folders (“Inbox”, “Outbox”, “Sent”, “Draft” and “Deleted”) 
cannot be renamed or deleted.
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Filtering received e-mail messages

You can classify e-mail messages by specifying rules for a created folder. You can 
also classify incoming e-mail messages automatically.

Creating a new filter
1. On the Index screen, tap the “Option” menu and then tap “Filter…”.

The Filter settings screen will be displayed.

New button Tap to create a new filter.
Edit button Tap to edit the filter rules.
Delete button Tap to delete a filter.
Execute Filtering 
button

Tap to start filtering received e-mail messages to folders that 
meet the specific rules.

Filtering 
automatically 
checkbox

When selected, incoming e-mail messages will be 
automatically saved in the folder that meets the specified 
rules.

Filtering automatically
checkbox

Execute Filtering 
button

New button

Edit button

Delete button
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2. Tap “New” on the Filter settings screen.
The New Filter screen will be displayed.

3. After setting the necessary items, tap  to save the filter rule.
The display returns to the Filter settings screen displaying the created filter.

4. For every incoming e-mail message to be filtered, select “Filtering 
automatically”.
To execute filtering at this time, tap “Execute Filtering”.

5. Tap  to close the Filter settings screen.
6. Tap  to close the EMail application and save the created filter settings.

Caution! Be sure to carry out step 6 (close the EMail application) to save the 
created filter settings. Resetting or restarting the Zaurus without 
closing the EMail application will clear the new filter rules.

Classifying e-mail messages
1. On the Filter settings screen, tap to select “Filtering automatically”.

The e-mails will be automatically classified when received.
They will be displayed in the selected color on the Index screen of the selected 
folder.

Folder Name select 
button

Tap and select a folder for which you want to make rules. 
Create folders in advance (see page 110).

Color Tag button Tap to set the background color for the Index screen for 
filtered e-mail messages according to the specified rules.

Item select 
drop-down list button 
and field

Tap the desired item and enter or select the rule for each 
field you want to make settings.
• From: e-mail address of a sender entered in the From field
• To: e-mail address of a recipient entered in the To field
• Subject: characters entered in the Subject field
• Body: characters entered in the Body field

Folder Name 
select button

Tap and select 
“and” / “or”Item select drop-down

list button and fields

Color Tag button
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When this checkbox is not selected, tap “Execute Filtering” to classify e-mail 
messages.

Note:
• Filtering is carried out for all filters simultaneously. It is not possible to make 

filter settings for each filter.
• To remove the background color, tap and hold the e-mail on the Index screen 

and then tap “Remove color tag” in the pop-up menu (see page 108).

Editing the filter
1. On the Filter settings screen, tap the desired filter you want to edit.
2. Tap “Edit”.

The Edit filter screen will be displayed.
3. Modify the filter rule.
4. Tap  to save the modification.
5. Tap  to close the Filter settings screen.
6. Tap  to close the EMail application.

Caution! Be sure to carry out step 6 (close the EMail application) to save the 
modified filter settings. Resetting or restarting the Zaurus without 
closing the EMail application will not save the modification.

Deleting a filter
1. On the Filter settings screen, tap the desired filter you want to delete.
2. Tap “Delete”.

A confirmation message will be displayed before the filter is deleted.
3. Tap “Yes” to delete the filter.

The selected filter will be deleted.
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Searching for received e-mail messages

You can display specific e-mail messages, such as by subject, by date, etc.

1. On the Index screen of the Inbox folder, tap the “Option” menu and then tap 
“Search…”.
The Search screen will be displayed.

2. Specify the search conditions.

3. Tap .
The e-mail messages searched will be displayed on the Index screen.
Tapping “Search Cancel” cancels the search function.

From combobox Searches for e-mail messages by the selected or entered 
sender.

Recipient combobox Searches for e-mail messages by the selected or entered 
recipient.

Subject field Searches for e-mail messages including character strings 
entered in the Subject field.

Body field Searches for e-mail messages including character strings 
entered in the Body field.

Arrived date option To search for e-mail messages by arrival date, turn the 
checkbox on and tap the Date button to specify the desired 
date.

Arrived date option
Date button
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Moving or duplicating e-mails between the 
Internal Flash and memory cards

You can move or duplicate e-mail messages among the Internal Flash memory, CF 
card and SD memory card.

1. Insert the memory card.
2. On the Index screen, move the focus to the e-mail messages you want to move 

or duplicate.
3. Tap the “File” menu and then tap “Copy/Move mail…”.

The Copy/Move Mail screen will be displayed.

4. Select the desired option.

5. Tap “OK” or  to execute the duplication or move.

Save option Select one or all e-mail messages in the folder.
Copy/Move option Select the option: Copy or Move.
Destination option Select the destination to be duplicated or moved.
Add/Replace option Select whether the e-mail message is added or replaced 

in the destination.
OK button Executes the duplication or move.

OK button

Save option

Copy/Move option

Destination option

Add/Replace option
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Voice Recorder
You can record and save audio files in the Internal Flash memory or on an expansion  
memory card by using the built-in microphone (at the bottom left on the back of the 
unit) of the Zaurus.
Recorded data can be heard from the built-in speaker (at the top left on the back of 
the unit) or by a commercially available stereo headphone (diameter of the plug: 2.5 
mm).

Note:

• Be aware of the volume setting. Do not damage your ears. Tap  on the 
taskbar and adjust the slider before or during playback.

• When using headphones, you can hear all sounds including screentaps and 
alarms from the headphone.

Overview

Control (Index) screen
1. On the Applications Home screen, tap the “Voice Recorder” application icon.

The Control (Index) screen appears.

Stop icon
Play icon
Rewind icon
Forward icon

Time slider

Record icon

Delete icon
Time indicator

Status indicator

Column buttons 
Tap a heading to sort 
the recorded files.

Input Gain indicator
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• Recorded voice can also be saved on the expansion memory card inserted into 
the Zaurus (see page 121).

File menu
Record Starts recording.
Stop Stops recording or playback.
Play Plays back the selected file.
Rew Rewinds for 1/10 of the total playback time by tapping once.
FF Advances 1/10 of the total playback time by tapping once.
Rename Renames the selected file. Up to 100 character spaces are 

available.
Delete Deletes the selected file.
Delete all Deletes all files in WAV format.

Option menu
Refresh List Updates the file names modified on the Files Home screen, 

etc.
Auto Refresh When turned on, updates the file names on the Index 

screen every time you insert/remove memory cards
(When turned on, it may take some time until file names 
appear if the memory card has a large number of files).

Preferences Opens a screen to set up the Voice Recorder preferences.
Help Displays online help.

Record icon Starts recording.
Stop icon Stops recording or playback.
Play icon Plays back the selected file.
Rewind icon Rewinds for 1/10 of the total playback time by tapping once.
Forward icon Advances 1/10 of the total playback time by tapping once.
Delete icon Deletes the selected file.
Status indicator Indicates the recording or playback status.
Time slider Indicates the recording (red) or playback (green) time.
Time indicator Indicates recording time/recordable time or playback time/

total playback time.
Input Gain indicator When the Voice Recorder is stopped, tap to open the 

Preferences screen (see page 121). Adjust the slide to 
change the Input Gain.
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Recording

1. If you want to record files on a CF or SD/MMC memory card, select it from the 
Preferences screen on the Option menu (see page 121).

2. Turn on the Zaurus, then press and hold the Rec key about 1 second.
The time indicator shows the available recordable length of time (right) and the 
actual recording length (left).

3. To stop recording, tap  or press the SELECT key.
The created files will be displayed in the Index. 

Note:

• It takes approximately 5 seconds to start recording when the Rec key is 
pressed while the Zaurus is on. If the CF card or the SD card is inserted in the 
Zaurus, it takes approximately 7 seconds.

• You can turn on the power and start recording by pressing the Rec key when 
the power is off (see page 121).

• You can also record by tapping the “Voice Recorder” icon on the Applications 
Home screen, and then tapping  on the Control (Index) screen.

• The recorded file will be saved in WAV format . In the Internal Flash memory, 
it will be saved in the “x-wav” folder within the “audio” folder.

• The default file will be named as follows: recording01, recording02, 
recording03,... If you want to rename the file, use the “Rename...” on the “File” 
menu. The slash (/), period (.) and currency symbols, etc. cannot be used.

• While playing a file with the Media Player, Internet browsing, transferring e-
mail messages, or communicating with a PC, etc., recording is not possible.

• Available recordable length of time varies depending on the free memory 
space of the storage device and Voice Recording format (see page 121).

• If memory space is lacking during recording, recording stops automatically. 
Try again after deleting unnecessary files.

Time indicator
(recording time/
recordable time)
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• For available memory space less than the values listed below, recording will 
be canceled.

• Turning off the power will stop recording.
• Alarm setting will be disabled during recording.

Playing

Recorded data will be played back from the built-in speaker on the back of the 
Zaurus, or from a headphone attached to the stereo headphone jack.

1. From the file Index on the Control screen, tap the desired file.
2. Tap , press the OK key, or press the SELECT key.

The selected file will begin playing.

•To stop playback, tap  or press the SELECT key.

Renaming a recorded file

1. In the Index, tap the recorded file you want to rename.
2. Tap the “File” menu and then tap “Rename...”.

The Rename screen will be displayed.

3. Modify the current file name.
4. Tap  to save the new name.

Note: Files cannot be renamed when recording or playing a file.

Deleting a recorded file

1. In the Index, tap the recorded file you want to delete.
2. Tap the “File” menu and then tap “Delete...”.

A confirmation message appears.

If you want to delete all files from the Voice Recorder application, tap the “File” 
menu and then tap “Delete all...”.

3. Tap “Yes” to complete the deletion.

Internal Flash memory:
CF card:
SD memory card (MMC):

512 KB
100 KB
100 KB
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Setting the preferences

You can customize voice recording preferences.

1. On the Control screen, tap the “Option” menu and then tap “Preferences...”.
The Preferences screen appears.

2. Tap  to save the settings.

Save to Specify the save to destination. To select a card, insert 
the card beforehand. If either the SD Card or CF Card 
is selected and the selected card is not in the slot, the 
destination will default to the Internal Flash memory.

Voice Recording format Specify the compression rate in voice recording mode 
using the drop-down list button. Better sound quality 
(greater “kbps”) reduces total recordable time.

Input Gain Adjustment 
slider

Adjust the Input Gain (sensitivity of the built-in 
microphone).

Enable AGC Automatically adjusts the input level when the voice 
tone becomes loud or quiet. 

Turn on by Rec key 
checkbox

If you press the Rec key with the power off after the 
checkbox is checked, the power will turn on and start 
recording in approximately 9 seconds (when the CF 
card or the SD card is inserted in the Zaurus, recording 
starts in approximately 15 seconds).
When unchecked, the Zaurus will not turn on even if 
you press the Rec key. To prevent the recording 
function from launching by mistake, uncheck this box  
(After the power is turned on in another way, pressing 
the Rec key will launch the application and start 
recording even if this box is unchecked).

“Voice Recording format” 
drop-down list button

Input Gain Adjustment 
slider

Turn on by Rec key 
checkbox

Enable AGC checkbox
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Tools

City Time

You can select from six world times in this application.

1. On the Applications Home screen, tap the “City Time” application icon.
The City Time screen will be displayed.

To change cities
1. Tap the City button you want to change.

The Select City screen will be displayed. Regions are listed in alphabetical order 
on the left hand side with corresponding city names on the right.

Note: To find the desired region’s name, press the first character of the 
region’s name on the hardware keyboard. The focus moves to the 
matching region’s name.

Time Zone map

City buttons
Date and time indicators
Magnify button ( )

Night zone 
(dark area)

Daytime zone 
(bright area)
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2. Tap the desired region’s name and then the city name.
3. Tap  on the Select City screen.

The selected city name will be displayed on the button you tapped in step 1, and 
the setting will be saved.

Changing to other cities using the zone map
1. Tap the City button you want to change.

The Select City screen will be displayed.
2. Tap the “Go to Zone Map” button.
3. Tap and drag the stylus anywhere on the Time Zone map or press the cursor 

keys to move the focus until the desired city name appears.
You can magnify the map to find an exact city name location by tapping the 
Magnify button ( ). Tap it again to return the image to the original size.

4. When you find it, press the SELECT key or the OK key immediately while the 
pop-up window of the city name is displayed.
The city name on the button will change to that selected on the Time Zone map, 
and the setting will be saved.
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Clock

The Clock application shows the current time and date and can be used as a 
stopwatch.

1. On the Applications Home screen, tap the “Clock” application icon.
The Clock screen will be displayed.

Be sure to confirm beforehand that the current date and time are set correctly in the 
Date/Time application on the Settings Home screen.

Using a Stopwatch
1. Tap the Stopwatch mode radio button to switch to Stopwatch mode.
2. Tap the “Start” button to start (or resume) the stopwatch, and tap the “Stop” 

button to stop it. While the stopwatch is running, it displays hour, minute, and 
second. When it stops, a hundredth of a second is also displayed.

3. Tap the “Reset” button to set the time back to zero.
4. Tap the Clock mode radio button to return to clock mode.

Caution! While the stopwatch is running, the option “Suspend after” is 
disabled. Tap the “Stop” button to stop the Stopwatch mode to 
protect the LCD display and save battery consumption before 
starting the Clock mode or launching other applications.

Clock mode radio button
Stopwatch mode radio button

Start (Stop) button
Reset button
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Calculator

The Calculator application allows you to perform mathematical operations, including 
conversions. It functions the same way as a standard calculator.

Note: Be sure to tap “C.CE” before starting calculations.

1. On the Applications Home screen, tap the “Calculator” application icon.
The Calculator screen will be displayed.

2. Perform the calculation by tapping the numeric and mathematical symbol keys 
on the screen.

Note:

• Should you enter a wrong equation (+, –, ×, etc.), be sure to enter the correct 
equation after the wrong equation.

• Be sure to tap “C.CE” before performing the next calculation.

“+/–” button
Changes a positive 
number to a negative 
number and vice versa.

“M+” button
Adds a number to 
the memory.

“R.CM” button
Displays the memory’s 
content, and tapping it 
twice clears the 
memory.

“Conv.” button
Switches the 
calculation mode 
between standard and 
conversion mode.
This button toggles 
between “Conv.” and 
“Calc” every time the 
button is tapped. “C.CE” button

Clears the number 
entered last, and 
tapping it twice 
clears the current 
calculation.

“M–” button
Subtracts a number 
from the memory.



Tools 126
Rate Conversion
In the conversion mode, you can convert currencies.
Using this function, you first set the conversion rate, then perform conversions 
based on the set rate.

To set the Rate
1. Tap “Conv.”.

The on-screen keyboard changes to the conversion layout.

2. Tap “C.CE”.
3. Tap “Rate”.

“R” will be displayed at the left edge of the display area.
4. For example, when $1 equals 125 yen, enter “125” then tap “Rate”.

This registers $1 = 125 yen.
5. After setting the rate, you can perform conversions (below).

Note:

• When changing an already set rate, proceed from Step 2.
• To return to the normal calculator, tap “Calc”.
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Rate Calculation
In this example, the rate is set to $1 equals 125 yen.

• Calculating a foreign currency amount for a certain number of dollars
(For example, how many Japanese yen for $15)

1. Enter “15” then tap “ratemult”.
“1875” will be displayed in the display area ($15 equals 1875 yen).

• Calculating the number of dollars for a certain amount of foreign currency
(For example, how many dollars for 1500 Japanese yen)

1. Enter 1500 and then tap “ratediv”.
“12” will be displayed in the display area (1500 yen equals $12).
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Help Browser

The Help Browser is a hypertext help system that works in a similar way to a Web 
browser.

1. On the Applications Home screen, tap the “Help Browser” application icon.
2. Tap a blue word to jump to the page concerning the word.

Note: With the following methods, you can open the context-sensitive help 
screen of the Help Browser (not available for all applications).
• Tap  for application help screen.
• Tap the “Option” menu and then tap “Help” on the Index screen of 

applications.

Bookmarks menu
Add Bookmark Adds the current page to the bookmarks.
Remove from Bookmarks Removes the current page from the saved 

bookmarks.

Bookmarks menu Home icon
Forward icon
Backward icon
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Registering bookmarks
By registering frequently-used pages, you can easily jump to that page.

1. Display the Help Browser page you want to register to the bookmarks.
2. Tap the “Bookmarks” menu and then tap “Add Bookmark”.

The title of the page will be registered.
Once you have registered it, the title of the bookmarked page will be displayed in the 
Bookmarks menu. Tap the bookmarked page in the Bookmarks menu to jump to that 
page.

Removing bookmarks
1. Tap the “Bookmarks” menu and select the bookmarked page that you want to 

remove from the menu.
The bookmarked page will be displayed.

2. Tap the “Bookmarks” menu and then tap “Remove from Bookmarks”.
The bookmark of the page you are on will be removed from the bookmarks.
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Settings

Add/Remove Software

In addition to the application software that has been pre-installed on the Zaurus, you 
can install additional applications (Linux/Qt/Java) which have been downloaded 
from the Internet, etc. to the Zaurus. To install software to the Zaurus, copy the 
desired software packages (.ipk) to the Zaurus and then install them using the 
Add/Remove Software application.
Software packages can be found on the following:
• Our Web site: http://myzaurus.com
• CD-ROM supplied

Digital camera software, Expert software, etc. are included.

Note:

• Software packages must be ipk format (*.ipk).
• If the installed software does not launch, tap and hold the installed application 

icon for a few moments, then turn on the “Execute with root privilege 
(not secure)” checkbox on its Details screen. The root privilege is executed, 
but the security is not guaranteed.

• After additional software is installed using a software package (*ipk), the 
package will remain in the Internal Flash memory or memory cards. 
Deleting this package will increase the Internal Flash memory space 
(Even if the software package (*ipk) is deleted, the installed software will 
operate properly).

Copying the software package to be installed
Use one of the following methods to copy the desired software package (*.ipk) to the 
Zaurus.

Using the Opera Browser application
Establish a connection to the Internet and launch the Opera Browser. Access 
any web site from which you can download software packages, such as: 
http://myzaurus.com (or others). Tap the package to start downloading. 
For details on how to use the Opera Browser application, see page 77.

http://myzaurus.com
http://myzaurus.com
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Using the memory card
Use a memory card, such as a CF or SD card, to save the downloaded software 
package. If your PC has a card reader, copy the desired software packages to 
the memory card, and then insert the memory card into the Zaurus.

Using the Zaurus File Transfer application
Use the Zaurus File Transfer application to save the software package 
downloaded from Web sites on the Internet, or copied from the CD-ROM, to a 
PC. If the Zaurus File Transfer application has been already installed to a PC, 
copy them to the Zaurus by using this application. For details on how to use the 
Zaurus File Transfer application, refer to the online manual (Zaurus File 
Transfer application).

Installing Packages
1. Copy the software packages (*.ipk) to install to the Zaurus (see the section 

above).
2. On the Settings Home screen, tap the “Add/Remove Software” application icon.

The Add/Remove Software screen will be displayed.

3. On the Add/Remove Software screen, tap the “Install packages” button.

“Install packages” button Installs software packages (.ipk) copied on the 
memory cards or Internal Flash memory.

“Install packages via 
networks” button

Installs directly software packages (.ipk) on a 
network to the Zaurus.

“Uninstall packages” button Tap to uninstall software.
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The Index screen for file installation will be displayed listing software packages.

4. Tap the package you want to install.
Or move the focus to the package you want to install and then tap the “Install” 
button.
The Select Install Storage screen will be displayed.

5. Tap the radio button of the storage media (Internal Flash, CF or SD) you want 
to install the packages to, and then tap  to execute the installation.

6. On the confirmation screen, tap “OK”.
The display turns to the Index screen with the “installed” package icon.

7. Tap  twice to close the Add/Remove Software application to complete 
installation.
The installed software icon is listed on the related Home screen, and can be 
launched from there.

Note:

• Be sure to perform step 7 above to complete installation.
• You can change the order of the installed software icon on the Home screen 

using the Tab Settings application on the Settings Home Screen (see page 
161).

• To install multiple software packages, repeat steps 4 through 6 and then 
step 7.

• If an error message appears during installation, follow the instructions 
displayed on the screen.

• Some software packages cannot be installed on the memory cards (They can 
be installed only in the Internal Flash memory).

“Install” button

Icons
: Not installed
: Installed

Column button
Tap to sort software 
packages by name or 
version.

Software packages in the 
Internal Flash memory 
and memory cards are 
displayed.

Qt Menu icon
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• Some software packages may display the message on the confirmation 
screen in step 6 indicating that you need to reboot the Zaurus. 
In such cases, tap the Qt Menu icon on the taskbar after performing step 6, 
tap “Reboot” and then “Yes” on the screen (Without rebooting the Zaurus, you 
cannot complete installation. Be sure to reboot).

Installing packages via networks
You can copy and install software packages to the Zaurus directly from a server on 
the Internet.
Be sure to establish a connection to the Internet before installing software packages 
via networks (see page 167).

Index screen for installation via networks
1. On the Add/Remove Software screen, tap the “Install packages via networks” 

button.
The Index screen for installation via networks will be displayed.

“Upgrade” button Updates the package information.
Server Setting icon Displays the Package Servers screen where you can set up 

the servers/proxy servers and select a server.
Package Search icon Displays the Search Packages screen where you can enter 

a keyword and search for it from the package list.
Package Information 
icon

Displays the package information.

“Upgrade” button

Server Setting icon

Package Search icon

Package Information 
icon

Progress bar



Settings 134
Server setup
Configure the server from which you want to install packages.

1. On the Index screen for installation via networks, tap the Server Setting icon.
The Package Servers screen appears.

2. If you want to connect to a new server, tap the “New” button and enter the server 
name etc. in each field.

3. Select the server you want to connect to from the Servers list.
4. Tap  to connect to the selected server.

The software packages (.ipk) on the specified Web pages which are on the 
network will now appear.

Installing packages via networks

Servers list

“New” button

“Remove” button
Removes the 
selected server from 
the list.

Server name field
URL field

Proxy server for
connection field

Icons
: Marked for 
installation

: Not installed
: Installed
: Intended for 
deletion

Column buttons
Tap to sort software 
packages by the 
item.
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1. On the Index screen, double-tap the package you want to install.
Or move the focus to the package you want to install and then tap the Package 
Information icon ( ).
The Package information screen will be displayed.

2. Tap the “Install” button.
The Package information screen turns to the Index screen.
The package is now ready to be installed and the icon on the Index screen turns 
to .
If you tap , the icon turns to , and the package will not be installed.

Note:

• You can also make the software package ready to be installed without opening 
the Package information screen by tapping the Not installed icon ( ).

• If you want to install several packages, repeat steps 1 and 2.

3. Tap .
The Select Install Storage screen will be displayed.

4. Tap the radio button of the storage (Internal Flash, CF or SD) you want to install 
the package(s) and tap  to execute the installation.
The display turns to the Add/Remove Software screen.

5. Tap  to close the Add/Remove Software application to complete installation.
The installed software icon is listed on the related Home screen and can be 
launched from there.

Note:

• Be sure to perform step 5 to complete installation.
• If an error message appears during installation, follow the instructions 

displayed on the screen.

“Install” button

“Remove” button
Makes this package 
ready to be removed.

“Ignore” button
Ignores this package 
and returns to the 
Index screen.
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Searching for a package
You can search for a desired software package by keyword.

1. On the Index screen for installation via networks, tap the Package Search icon 
( ).
The Search Packages screen will be displayed.

2. Enter a word you want to find and then tap .
Searching starts.
The Package information screen for packages found will be displayed. 
If multiple matching packages are found, the information screen of the first 
package on the Index screen will be displayed. Tapping the “Ignore” button will 
display the next matching package information.
If you tap , the display returns to the Index screen where the matching 
packages are highlighted. 
If not found, the display returns to the Index screen.
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Uninstalling packages
If you uninstall a package, all information about the application (such as data and 
settings) are also deleted.

1. On the Add/Remove Software screen, tap the “Uninstall packages” button.
The Index screen for uninstallation will be displayed.

2. Tap the package file you want to uninstall.
Or move the focus to the package file you want to uninstall and then tap the 
“Uninstall” button.
A confirmation message will be displayed before the package is uninstalled.

3. Tap “Yes” to uninstall it.
4. On the confirmation screen that appears, tap “OK”.

The uninstalled package disappears from the Index screen.
5. Tap  twice to close the Add/Remove Software application to complete 

uninstallation.
The software icon will disappear from the related Home screen.

Note: Be sure to perform step 5 to complete uninstallation.

“Uninstall” button
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Removing packages installed via networks
The Index screen for installation via networks allows you to remove packages.

1. On the Index screen, double-tap the installed package you want to remove.
Or move the focus to the package you want to remove and then tap the Package 
Information icon.

2. On the Package Information screen, tap the “Remove” button.
The Package Information screen turns to the Index screen.
The package is now ready to be removed and the icon on the Index screen turns 
to .

Note: On the Index screen, tap the Installed icon ( ) you want to remove 
instead of performing steps 1 and 2 above.

3. Tap  to execute the removal.
The Index screen turns to the Add/Remove Software screen.

4. Tap  to close the Add/Remove Software application to complete 
uninstallation.
The application icon will disappear from the related Home screen.

Note: Be sure to perform step 4 to complete uninstallation.
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Setting the Appearance (Appearance)

The Appearance setting allows you to customize your desktop and window 
properties.

1. On the Settings Home screen, tap the “Appearance” application icon.
The Appearance has four tabs.

Wallpaper select 
button

Theme screen Design setting screen

Theme tab

Design tab

Font tab

Font setting screen Rotate setting screen

Rotate tab
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2. On the Theme screen, tap the desired design theme.
To change the theme details, tap the Design tab.
See the next section for information on how to set the wallpaper to the Home 
screen.

3. After making the necessary changes, tap  to save the settings.
The shape and design color of the button, scroll bar, etc. will be changed.

Theme tab Select the design theme for the Zaurus screen.
Design tab Customizes the screen properties in detail.
Font tab Bold fonts using for the Zaurus screen.
Rotate tab Select either “For left hand holding” or “For right hand 

holding” when tapping the key to switch from “portrait” 
to “landscape”.

Use Wallpaper checkbox When checked, applies the selected file to the 
wallpaper.

Wallpaper select button If the Use Wallpaper checkbox is selected, tap to select 
the desired wallpaper file.

Shade Text checkbox Select the checkbox to shade the type style of the 
application names on each Home screen.

Style drop-down list 
button

Select the styles for the graphical display from the list.

TitleBar drop-down list 
button

Select the color of the title bar from the list. 

Color Scheme drop-down 
list button

Select the schemes for the display from the list.



141 Settings
Setting the Wallpaper
You can set an image file to the wallpaper.

1. On the Design setting screen, check the “Use Wallpaper”.
2. Tap the Wallpaper select button.
3. From the screen that appears, select the desired image file for wallpaper and 

then tap .
4. Tap  to save the settings.

The settings will be effective immediately.

Note:

• For the dark wallpaper, shadow characters are recommended for easier 
viewing by checking the “Shade Text”.

• Image files of large size or insufficient memory may not complete the 
wallpaper setting.

• Some image files may not be displayed correctly for wallpaper.
• If you tap and hold an image file on the Files Home screen, the pop-up menu 

appears. Selecting “Set as wallpaper” allows you to apply the selected file to 
the Wallpaper. Selecting “Clear wallpaper settings” instead clears wallpaper 
setting. This wallpaper setting on the Files Home screen will be applied to that 
of the Appearance application.

Bolding Fonts
You can change the characters shown on the screen to bold. Bold characters are 
not available in some fonts.

1. On the Font setting screen, check the “use thick fonts”.
2. Tap  to save the setting.

The settings will be effective immediately.

Rotating the screen
Select either “For left hand holding” or “For right hand holding” when tapping the key 
to switch from “portrait” to “landscape”.

1. On the Rotating setting screen, check the direction you wish to rotate.
2. Tap “OK” to save the setting.

Press and hold the  ( ) key for several seconds to rotate the screen in the 
set direction.
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Using the Application Key (Application Key)

This application allows you to assign the following keys on the sliding cover to other 
keys: Home key, Calendar key, Address Book key, Menu key, EMail key,  key, 
Light key and Rec key.

1. On the Settings Home screen, tap the “Application Key” application icon.
The Set Application Key screen will be displayed.

2. Tap each drop-down list button to select the desired key.
3. Tap  to save the settings.

The settings will be effective immediately.

Note:

• If you assign the Menu key to other keys, it will not be available in each 
application as the Menu key. In this case, use the tap operation for menu 
operation.

Drop-down list buttons
List all keys.
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Backup Restore (Using memory card)

The Backup/Restore application allows you to make a backup file of the Zaurus’s 
data on an expansion memory card, or to restore it back to the Internal Flash 
memory of the Zaurus.
It is recommended that you use memory cards of 64 MB or more.
As certain types of data may even exceed 64MB memory cards, use cards large 
enough to accommodate all the desired data.

Caution!

• Be sure to use the AC adapter, not the battery pack, to carry out the backup 
and restore process. The backup and restore process cannot be carried out if 
the battery is exhausted.

• Be sure to save current editing data and close all applications before carrying 
out the backup and restore process.

• Do not press any key, tap the screen, or remove the expansion memory card 
during the backup and restore process.

• The passcode entered for security will also be backed up and restored.
• When the storage area in your Zaurus is less than approximately 1.5 MB, you 

cannot perform backup operations. Make space by deleting unnecessary files, 
etc. and try the backup operation again.

Backup
1. Insert the expansion memory card into the card slot while the Zaurus turned on.
2. On the Settings Home screen, tap the “Backup Restore” application icon.

The Backup/Restore screen will be displayed.

3. In the Backup/Restore options, tap the Backup radio button.
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4. Tap the left drop down list button then select the desired destination in the 
Media option.

5. Tap “Start”.
A confirmation message will be displayed.

6. Tap “Yes” to start the backup process.
When the backup process has been completed, the Zaurus will automatically restart.
The backup file will be automatically named in the format of yyyy-mm-dd-hh-mm, for 
example, 2004-12-26-11-45.

Restore
Caution! Restoring backup files will overwrite all files and passcode.

1. Insert the expansion memory card containing backup files into the card slot 
while the Zaurus turned on.

2. On the Settings Home screen, tap the “Backup Restore” application icon.
The Backup/Restore screen will be displayed.

3. In the Backup/Restore options, tap the Restore radio button.
4. Tap the left drop down list button then select the desired destination in the 

Media option.
5. Tap the drop-down list button and then tap the import file.
6. Tap “Start”.

A confirmation message will be displayed.
7. Tap “Yes” to start the restore process.
When the restore process has been completed, the Zaurus will automatically restart.

Note: Use of the Backup/Restore application on the supplied CD-ROM allows 
you to make a backup file on a PC. For more details, see its online 
manual in the CD-ROM.
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Beam Receive

You can transfer a single entry created in the Address Book, Calendar, or Todo List 
applications, or an image file, etc. using the IR port (IrDA) on the left side of the unit.
This section describes how to transfer data between the same models. The SL-
6000L/SL-6000N can transfer data with SL-5600 or SL-5500.

Setting
Be sure the IR ports are facing each other and are within 8 inches (approximately 
20 cm) of each other when transferring data by infrared beam.

Note: Avoid using mobile phones near the unit or exposing the unit to strong 
light, such as direct sunlight, during transmission. 
Otherwise transmission errors may occur, causing parts of the 
transmitted data to be altered or deleted.

Not more than 8 inches 
(approximately 20 cm)
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Beam Receive screen
The Beam Receive screen allows you to set preferences for IR communication.

1. On the Settings Home screen, tap the “Beam Receive” application icon.
The Beam Receive screen will be displayed.

Selecting the receiving mode
1. On the Settings Home screen, tap the “Beam Receive” application icon.

The Beam Receive screen will be displayed.
2. Tap the desired receiving mode (Manual, Automatic).
3. Tap  to save the settings.

The setting will be effective immediately.

Note: The Automatic-receiving mode consumes more battery power than the 
Manual-receiving mode. This is because the IR port is always in 
receiving mode when the Automatic option is selected.

Beam receive mode
Manual radio 
button

The Zaurus receives data in manual mode.
In this mode the Zaurus begins receiving data when you tap 
the “Start” button.

Automatic 
radio button

The Zaurus receives data in automatic mode.
The Zaurus starts receiving data any time the other unit 
sends data and the receiving Zaurus detects a signal.

Manual beam receive
Start/Stop 
button

Tap to start/stop the IR communication for manual beam 
receive.

Beam receive mode
Manual radio button 
(recommended)
Automatic radio 
button

Manual beam receive
Start/Stop button
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Transferring data between the same models
Receiving data in Manual mode
1. Receiving Unit

On the Settings Home screen, tap the “Beam Receive” application icon.
The Beam Receive screen will be displayed.
Tap the Manual radio button and then tap “Start” to enter receiving mode.

2. Sending Unit
Point the IR ports of both units at each other.

3. Sending Unit
To transfer application entry:

Open the Detail screen of the entry you want to send.
Then, tap the “Data” menu and then tap “Send by beam...”.

To send a file (such as text file, image file):
Display the Files Home screen and move the focus to the file 
you want to send. 
Then, tap the “File” menu and then tap “Send by beam...”.

4. Receiving Unit
The Beam Receive screen turns to the infrared receive screen within a few 
seconds. During data reception, the “Receiving...” message appears.
When the unit is finished receiving data, tap the “Add” button on the Infrared 
receive screen. When a file is received, select the destination if memory card is 
inserted.

The received data will be added to the specified application or folder on the 
receiving unit.
If the “Add” button is not tapped, the received data will not be added.
If you tap “Cancel”, the registration is canceled.

Information about 
the received entry

Add button
Adds the received data 
to the application (or 
specified folder) of the 
receiving unit. When 
the unit is finished 
receiving data, the 
“Add” button becomes 
effective.

Tap to cancel registration 
of the received data.
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5. Receiving Unit
Tap the “Beam Receive” application icon displayed on the taskbar to display the 
Beam Receive screen, and tap the “Stop” button to cancel receive mode.
Note:

• Be sure to tap the “Stop” button in step 5 as the battery will continue to drain 
in receive mode.

• To cancel sending, tap “Cancel” on the sending screen.
• When Address Book data is transferred to another Zaurus with the “Work 

Country” and “Home Country” fields left blank, the blank fields are 
automatically filled with “United States” at the receiving end (viewing the 
received Address Book data shows the “Work Country” and “Home Country” 
fields filled in as “United States”). If the “Work Country” and “Home Country” 
fields are filled in the original data, they are transferred unchanged.

Receiving data in Automatic receive mode
The Automatic receive mode notifies you of data transfer, even if you are in another 
application.

1. Tap the Automatic radio button on the Beam Receive screen.
2. Perform steps 2 to 4 above of “Receiving data in Manual mode” to start data 

transfer.

Note: To cancel sending, tap “Cancel” on the sending screen.

Notes on data transfer between models SL-5500 or SL-
5600 and SL-6000L/SL-6000N
Some entry items are different or do not exist in the same applications for SL-5500 
or SL-5600 and SL-6000L/SL-6000N. One model cannot receive items transmitted 
from the other model that does not have.
For example, when a completed task entry of the Todo List application is sent from 
the SL-5500 to the SL-6000L/SL-6000N, the “Completed Date” item is replaced by 
the date of transmission (as this item does not exist on the SL-5500).
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Adjusting the date and time (Date/Time)

The date and time setting allows you to set the current time zone, date and time. 
For time-critical functions to work properly, the built-in clock application must be set 
to the current date and time.

1. Tap the “Date/Time” application icon on the Settings Home screen, or tap the 
time indicator at the bottom right of the taskbar.
The Set System Time screen will be displayed.

2. Tap the Time Zone drop-down list button and select your time zone.

Note: The Time Zone drop-down list consists of 6 city names set using the 
City Time application. If your time zone is not found in the drop-down list, 
tap the City Time button and set it in the City Time application.

3. Tap the Time format drop-down list button and tap either 12 hour or 24 hour.
4. Tap the up and down arrows on the Hour and Minute spinboxes to set the 

correct time.
If you select the 12-hour format in step 3, select AM or PM by tapping the 
drop-down list.

5. Tap the Date button and then tap your current date on the mini-calendar.
• Tap the up and down arrows of the year spinbox to set the current year.
• Tap the month drop-down list button and select the current month.
• Tap  or  to change the setting month by month.
• Tap  or  to select the first month (January) or last month (December).

6. Tap the Weeks start on drop-down list button and tap the day you wish to start 
the weekly calendar: Sunday or Monday.

Weeks start on drop-
down list button

Time Zone drop-down 
list button

City Time button

Time format drop-down 
list button 

Date button

Date format drop-down 
list button

Hour and Minute
spinboxes

AM/PM drop-down list 
button 



Settings 150
7. Tap the Date Format drop-down list button and then tap the desired format.
The selected format applies to the Date column displayed on the Index screen 
of the application, etc.
M/D/Y (example, 12/26/04)
D.M.Y (example, 26.12.04)
Y-M-D (example, 04-12-26)
D/M/Y (example, 26/12/04)

8. Tap  to save the new date and time setting.

Note:

• To move the focus from steps 2 through 7, press the Tab key, as required on 
the hardware keyboard.

• You can adjust the date from January 1, 1970 to December 31, 2037 (GMT).
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Power Management (Light & Power)

Light & Power settings allows you to control the brightness of the backlight and auto 
power-off time to save the battery power in the following situations:
• when the Zaurus is not connected with the AC adapter 

(driven with the rechargeable battery)
• when the Zaurus is connected with the AC adapter

1. On the Settings Home screen, tap the “Light & Power” application icon.

2. Make the necessary settings.
For Battery power (upper section)
Tap the desired checkbox and then tap the “+” or “–” button of the spinbox to set the 
desired time. 

on Battery Power
Dim light after When selected, the backlight will be dimmed if no operation is 

performed in the specified time. The backlight will turn on again 
if you resume operation.

Light off after When checked, the backlight will turn off if no operation is 
performed in the specified time.
The backlight will turn on again if you resume operation.

Suspend after The power will turn off if no operation is performed in the 
specified time.

Brightness 
control slider

Turn the backlight on by pressing the Backlight key and move 
the slider to change the brightness of the backlight for the 
operation by the battery power. The actual brightness can be 
confirmed on the display as you adjust the slider.

Brightness 
control sliders
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For AC adapter (lower section)
Tap the “+” or “–” button of the spinbox to set the desired time.

When the AC adapter is connected, You must check the “Screen saver” or “Suspend 
after” checkbox.

3. Tap  to save the settings.

Note:
• The brighter the screen light, the more power is used.
• The darkest setting on the brightness control slider is equivalent to having the 

backlight turned off. Pressing the back light key will not turn it on when set with 
the darkest setting.

• The “Dim light after” option cannot be activated in the following cases:
– During slideshow of image files by the Imaging application
– During viewing of video files by the Media Player or Video Player application 

(both applications are included in the supplied CD-ROM)
– While using the Camera application (additional application in the CD-ROM)

• The “Suspend after” option for both power source (battery and AC adapter) 
cannot be turned off and does not function in the following cases:
– During slideshow of image files by the Imaging application
– During playback of music files and viewing of video files by the Media Player  

or Video Player application (both applications are included in the supplied 
CD-ROM)

– During data communication by beam or with a PC
– While the connection to the Internet is established for browsing and e-mail 

transfer

on External Power
Screen saver Check the checkbox to activate the screen saver. Uncheck 

the checkbox to deactivate the screen saver. The screen 
saver will be activated if no operation is performed in the 
specified time (The display background will turn white and the 
Zaurus logo will be displayed. The display position changes in 
10-second intervals).

Suspend 
after

Check the checkbox to activate (the “Suspend after” function 
will not activate when the check is removed). However, when 
the screen saver checkbox is unchecked, the “Suspend after” 
checkbox cannot be unchecked.
The power will turn off if no operation is performed in the 
specified time if the AC adapter is connected.

Brightness 
control slider

Turn the backlight on by pressing the Backlight key and move 
the slider to change the brightness of the backlight for the 
operation by the AC adapter. The actual brightness can be 
confirmed on the display as you adjust the slider.
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– While the Stopwatch of the Clock application is running
When the battery power is used and the option “Suspend after” does not 
function, the “Screen saver” option will be activated in the specified time for 
the LCD display protection.

• While the Stopwatch of the Clock application is running, the “Screen saver” 
option is also disabled.

Adjusting the touch panel (Recalibrate)

Calibration setting allows you to calibrate the screen.

To ensure that your Zaurus correctly matches the positions you tap on the screen 
with the screen’s contents, you may occasionally need to recalibrate.

1. On the Settings Home screen, tap the “Recalibrate” application icon.
The screen will change and show a cross hair on the top left of the screen.

2. Tap the stylus in the center of the cross hair.
The cross hair will then move to another position.

3. Tap the cross hair once again.
4. Repeat this process until recalibration automatically finishes.
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Setting security (Security)

The Security application allows you to set your own passcode to protect your Zaurus 
from unauthorized use.
Once you set the passcode and enable the setting, you must enter it every time you 
turn on the Zaurus.

Caution! Use this function with care. If you forget your passcode, you need to 
carry out “Format” from the Maintenance menu. You will lose all data 
created and saved, and additional software added to the Zaurus. 
For detailed information on how to carry out “Format”, refer to the 
separate Start-up Guide.

Note:

• When you have set or changed the passcode on the Zaurus, enter and save 
the same passcode on the “Zaurus Manager” screen on your PC. Otherwise 
you will be asked the passcode every time communication between the 
Zaurus and your PC is established (Zaurus File Transfer, Backup/Restore, 
Intellisync for Zaurus, Qtopia Desktop for Zaurus, etc.). For details, see 
respective online manuals for the applications.

• If the security passcode is set, functions that turn on the Zaurus automatically 
(such as the alarm function of the Calendar application) do not function. For 
example, if you set the alarm using the Calendar application without setting 
the passcode, the Zaurus turns on at the set time and displays the alarm 
screen. When the passcode is set, the Zaurus turns on at the set time, but 
does not display the alarm screen.

Overview
1. On the Settings Home screen, tap the “Security” application icon.

The Security Settings screen will be displayed.

Note: If you have set the passcode in the set-up procedure or in this 
application, the passcode entry screen will be displayed. 

Clear passcode button
Require passcode at
power-on checkbox

Set passcode button
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Setting the passcode
By default, the passcode is not registered. Use the on-screen-numeric keyboard to 
enter the passcode.

1. Tap the “Set passcode” button.
2. Enter your passcode.

Up to 8 characters can be entered. The passcode you enter will be replaced with 
“*” for your security.

Note: The passcode supports strong authentication. You can enter a passcode 
using the number keys on the screen or letters using the keyboard. 
Letters are distinguished between upper case and lower case.

3. Tap “OK”.
To cancel setting, tap .

4. Enter the same passcode again.
5. Tap “OK”.

You will return to the Security Settings screen.
6. Tap  on the Security Settings screen to save the passcode.

Turning the Security setting on or off
1. On the Security Settings screen, tap “Require passcode at power-on” checkbox 

to turn Security setting on.
2. Tap  on the Security Settings screen to save the setting.
To turn the Security setting off, clear the “Require passcode at power-on” and tap 

.

Entering the passcode at startup
When the “Require passcode at power-on” is checked, you need to enter the 
passcode at startup.

1. Enter the passcode at startup.
The passcode you enter will be replaced with “*” for your security.

2. Tap “OK”.
The Home screen will be displayed and then you can start operation.

Note: If you enter an incorrect passcode, the screen will remain on the 
passcode entry screen and the Home screen will not be displayed.
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Changing the passcode
1. Tap the “Change passcode” button.

The current passcode will be cleared.
2. Enter the new passcode and then tap “OK”.
3. Enter the same passcode again and then tap “OK”.

You will return to the Security Settings screen.
4. Tap  on the Security Settings screen to save the passcode.

Clearing the passcode
1. Tap the “Clear passcode” button and then tap  .
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Sound Settings

You can customize the sound for start-up, received e-mail, etc.

1. On the Settings Home screen, tap the “Sound Settings” application icon.

2. From the Sound Type list, tap the sound type for which you want to change the 
sound.

3. Tap the Sound select drop-down list button and select the desired sound from 
the list that appears.
To hear the assigned sound, tap .

4. Tap  to save the settings.

Note:

Startup: Sound at startup
StartSync: Sound for starting synchronization with a PC using the 

Intellisync for Zaurus or Qtopia Desktop for Zaurus.
SambaEvent: (used for additional software)
ReceivedMail: Sound for received e-mail

Default button
Reverts to the 
default sound 
setting.

Sound select drop-
down list button

Select the sound 
from the list that 
appears.

Play button
Plays the selected 
sound.

Select File button
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Assigning other WAV files
In addition to the default sound files of the Zaurus, you can select WAV files stored 
on the Internal Flash and the memory cards inserted.

1. On the Sound Settings screen, tap the Select File button.
2. On the screen for selecting WAV files that appears, tap the file you want to 

assign.
The name of the selected file will be displayed in the File Name field at the 
bottom of the screen.

3. Tap .
The file will be selected on the Sound Settings screen and displayed in the 
Sound select drop-down list button.

4. Tap  to save the settings.
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System Info

This application presents a set of information each presenting a different aspect of 
the system’s state.

1. On the Settings Home screen, tap the “System Info” application icon.
The System Information screen will be displayed.

2. Tap the desired tab.
3. Tap  to close the application.

Note:

• In the Memory tab, the memory indicator may vary depending on the status 
before the Zaurus is turned off, and when the Zaurus is turned off and then 
turned back on. This is because the memory counts the memory size used for 
internal purposes as well.

• The Internal Flash memory holds the compressed data, files and additional 
software. If they are to be transferred to the memory cards or a PC, they are 
expanded to the original size.

Memory Full Errors
To prevent the operation speed from slowing when the Internal Flash memory is 
almost full, a message warning you that data cannot be saved appears on the 
screen if the Internal Flash memory drops below a few hundred kilobytes. Should 
such cases occur, delete files no longer required, particularly large-volume files, 
such as music, video and image files.

Errors that can be caused by lack of memory:
• You are unable to create a new entry, delete an existing entry, or transmit (as a 

result of lack of memory).
• You are unable to copy or paste.

Memory tab Shows memory usage for the system and application software.
Storage tab Shows storage usage.

Shows Internal Flash memory usage.
If a memory card is inserted into the Zaurus, the memory card 
information will be added on the screen.
The added application software installed will increase the used 
space.

Version tab Provides information on the system’s software.
Device tab Shows information of CF Card slot and the USB port (the 

information of the SD card slot is not displayed).
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• You cannot delete Address Book, Calendar or Todo List entries, etc.
• Delays in operation occur, such as taking longer than normal to switch between 

display screens and to display screens.
• Data you are editing is lost without saving if you attempt to operate other functions 

and then return to the Edit screen.
• Data you are editing is lost without saving if you turn the Zaurus off and then on 

again.
• Alarm setting is not executed.
• Other functions may not operate properly.

Information on memory fragmentation
Edited data will be saved in the memory (where the system or application software 
operates) of the Zaurus. Due to accumulated operations, memory fragmentation 
may occur, causing a memory shortage warning to be displayed, and turning the 
Zaurus off.
To clear memory fragmentation, Reboot or Reset operations (see the “Appendix” 
chapter in the separate Start-up Guide).
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Tab Setting

Tab setting lets you create original Home screens.

Overview
1. On the Settings Home screen, tap the “Tab Setting” application icon.

The Tab Setting screen will be displayed.

Note:

• The Files Home screen is not a target for editing Tab Setting.
• There can be up to nine Home screens.
• Each Home screen can contain up to 32 applications.

Adjusting the order of tabs and applications
You can adjust the order of the Navigation tabs for each Home screen (except the 
Files Home screen), and rearrange the application icons on the Home screens.

1. On the Tab Setting screen, tap the tab or application to be moved.
2. Move it to any position by tapping the Up and Down buttons.
3. Tap .

A confirmation screen will be displayed.
4. Tap “Yes”.

The new setting will be saved and the display will return to the Home screen.

Focus
Tapping the Tab 
area or Application 
area moves the 
focus. 

Application area
Displays the 
applications in the 
Home screen that is 
currently the focus 
of the Tab area. 

Tab area

Down button

Up button

New button
Edit button Delete button

Application move button

Default button
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Adding tabs and application icons
You can add Home screens or add application icons to existing Home screens.

1. Tap in the area (Tab or Application) where you want to add a tab or icon, moving 
the focus there.

2. Tap the New button ( ).
The New Tab or New Application screen will be displayed.

3. Enter a name.
Tap the icon on the New Tab or New Application screen to select it from the list. 
You can also select the icon by directly entering its name.

4. When adding an Application icon, tap the Icon select button to select the icon 
from the list. You can also select a program by entering its name. To select a 
program, tap the Program select button and select the program from the list.

5. Tap  on the New Tab or New Application screen to save the newly set tab 
or icon.

6. Tap .
A confirmation screen is displayed.

7. Tap “Yes”.
The settings will be saved and the display will return to the Home screen.

Note: If no application is found in the tab, the Navigation tab of the Home 
screen is not displayed.

Icon select button
Program select button
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Editing the tabs and application icons
You can change Navigation tabs for the Home screen, application icons and names.

1. On the Tab Setting screen, tap the tab or application you want to edit.
2. Tap the Edit button ( ).

Editing is accomplished by following steps 3 through 7 for “Adding tabs and 
application icons” (see page 162).

Note: Tab Setting application cannot be edited.

Deleting tabs and application icons
You can delete Navigation tabs for Home screen and application icons.

1. On the Tab Setting screen, tap the tab or application you want to delete.
2. Tap the Delete button ( ).
3. Select “Yes” on the confirmation screen.
4. Tap .

A confirmation screen will be displayed.
5. Tap “Yes”.

The settings will be saved and the display will return to the Home screen.

Note

• Applications tab and Settings tab cannot be deleted.
• Tab Setting application cannot be edited or deleted.

Moving an application to another Home screen
1. On the Tab Setting screen, tap the application you want to move.
2. Tap the Application move button ( ).

Select Tab screen will be displayed.
Brackets will appear around the Home screen name where the application 
currently is located.

3. Tap the destination Home screen name to select it.
The display returns to the Tab Setting screen.

4. Tap the destination tab in the Tab area, and check that the moved application 
is at the lowest part of the Application area.
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5. Tap .
A confirmation screen will be displayed.

6. Tap “Yes”.
The setting will be saved and the display will return to the Home screen.

Returning to the Initial Configuration
You can return your edited Home screen and application icons back to their initial 
configuration. Added tabs and icons will be left unchanged.

1. On the Tab Setting screen, tap the Default button ( ).
2. On the confirmation screen, tap “Yes”.

After several seconds, the settings will return to their initial configuration and the 
display will return to the Applications Home screen.
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PC Link

PC Link allows you to select the method of connection for the PC Link software 
(Intellisync for Zaurus, etc.). PC synchronization can be started by tapping a button 
on the PC Link screen (However, settings on the PC Link software are necessary. 
For details, see each operation manual for the software).

Selecting the connection method
1. On the Settings Home screen, tap the “PC Link” application icon.

The PC Link screen will be displayed. 

2. Tap the drop-down list button and select “USB–I/O (default)”, or “Serial” to 
change the setting into the same method as on the “Zaurus Manager” screen 
on your PC, if necessary.

3. Tap  to save the settings.

Note:

• If you changed the method of connection in this PC Link application, also 
change the setting on the “Zaurus Manager” screen on your PC, into the same 
method as on the Zaurus. Otherwise communication between the Zaurus and 
your PC cannot be performed.

• For details, see respective online manuals for the applications (Zaurus File 
Transfer, Backup/Restore, Intellisync for Zaurus, Qtopia Desktop for Zaurus, 
etc.).

This is for future 
extension option.

Sync Start button

Drop-down list button for 
connection methodClear Sync Info button

Tap to clear 
synchronization 
information for Re-
synchronization.
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USB–TCP/IP (advanced)
Options for the method of connection include “USB–TCP/IP (advanced)” for 
functional extension.
If “USB–TCP/IP (advanced)” is selected, the Hostname and USB IP fields are 
selectable.
Do not change the hostname and IP address unless you need to change them. 
Changing the preset values does not allow you to connect with the currently used 
PC.
• Hostname: zaurus
• IP address: 192.168.129.201
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Network Settings (Network)
The Network application allows you to set up LAN preferences and dial-up.
• Wireless LAN : for local area network connection using a wireless LAN card 

(SL-6000N) or the wireless LAN module (SL-6000L)
• LAN : for local area network connection using the LAN card
• Dial-up : for dial-up connection using a modem card or IrDA port

(Modem or IrDA)
The Wizard screen guides you through all setting screens and allows you to 
complete necessary network settings including EMail settings, such as e-mail 
addresses and mail server.
Without the Wizard screen, you will make settings only for Internet connections. The 
EMail settings can be made inside the EMail application.

1. On the Settings Home screen, tap the “Network” application icon.
The Network screen will be displayed consisting of two tabs: 
Services and Current.

Overview

Network setting list

Services tab

Current tab

Connection type 
drop-down list button

Connect button

Auto-connect checkbox
Show confirmation 
screen checkbox

Select the access point 
for automatic connection 
checkbox

Change order button 
(for Wireless LAN only)
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Services tab
Network setting list Lists the settings according to the connection type 

selected by tapping the connection type drop-down 
list button.

Select the access point 
for automatic connection 
checkbox

Select the setting you want to use when connecting 
automatically. The setting marked with a check has 
connection priority (see page 191).
For Dial-up and LAN connection, you can check 
only one checkbox. For wireless LAN connection, 
you can check several checkboxes. Also select 
“Auto-connect” to execute connection 
automatically.

Connection type
drop-down list button

Tap to select the connection type.
Wireless LAN:Lists the settings for Wireless LAN 

connection
LAN: Lists the settings for LAN connection
Dial-up: Lists the settings using a modem 

card or IrDA port
List: Lists all connection settings

Wizard button Tap to create a new setting by following the 
on-screen instructions. The network and EMail 
settings are included.

Add button Tap to create a new setting manually.
Edit button Tap to edit the selected setting.
Delete button Tap to delete the selected setting.
Connect button Tap to start connecting to the network.
Change order button
(Up/Down)

Tap to change the priority order of the Wireless 
LAN setting with ESS-ID. These buttons are 
available when the setting list for “Wireless LAN” is 
displayed. The priority for setting without ESS-ID 
cannot be changed.

Auto-connect checkbox When checked, the Zaurus will connect 
automatically to the network using the access point 
for the communication card inserted (see page 
191).

Show confirmation 
screen checkbox

When selected, a confirmation screen for the 
access point will be displayed before connecting 
automatically (see page 191).
Dimmed if “Auto-connect” is cleared.

Current tab Displays the current connection status depending 
on the communication device connected. The MAC 
address is also displayed for the wireless LAN.
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Creating settings using the Wizard screen

1. On the Network screen, tap the “Wizard”.
The Internet Setting Wizard screen will be displayed.

This screen allows you to select the connection type.

Edit menu
Wizard Select to create a new setting by following the 

on-screen instructions. The network and EMail 
settings are included.

Add Select to create a new setting manually.
Edit Select to edit the selected setting.
Delete Select to delete the selected setting.
Duplicate Select to create a new setting by using a duplicate 

of the selected setting.
Import Tap to import a network setting file and add the 

network setting.
Export Tap to create a network setting file and save it on 

the Internal Flash memory or memory card.

Connection Type radio 
buttons

Select the connection type.

Next button Moves to the next screen.

Connection Type 
radio buttons

Next button
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Creating a new Dial-up Modem/IrDA setting
1. On the Internet Setting Wizard screen, tap the “Dial-up (via Modem)” or “Dial-up 

(via IrDA)” radio button.
2. Tap “Next”.

Fill out the following screens according to your connection type.
If necessary, tap “Back” on the following screens to modify settings on the 
previous screen.

3. When “Dial-up (via Modem)” is selected, Dial Mode Settings screen will be 
displayed. Select the dial mode and then tap “Next”.

When “Dial-up (via IrDA)” is selected, Access Number Settings screen will be 
displayed. Go to step 4.

4. Enter the telephone number of your nearest access point and then tap “Next”.

Telephone Number 
field
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5. Enter your connection username and connection password and then tap “Next”.

6. Enter your Email username and password for receiving e-mails and then tap 
“Next”.
Tapping “Next” with the username left blank will skip to step 9.

Username field Enter your connection account.
Password field Enter your password.

Username field Enter your Email account.
Password field Enter your Email password.

Username field
Password field

Username field
Password field
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7. Enter your e-mail server information for sending/receiving e-mails and then tap 
“Next”.

8. Enter the e-mail sender and e-mail address and then tap “Next”.

9. Enter the DNS server information and then tap “Next”.

Incoming mail 
(POP3) field
Outgoing mail 
(SMTP) field

Email sender field

Email address field

Obtain/Specify DNS 
Information radio 
buttons

Primary DNS field
Secondary DNS field
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10.Enter your connection name and confirm the contents of the setting.

11.Press the OK key or tap “Register”.
A confirmation screen will be displayed.

12.Press the OK key or tap “Complete”.
The created settings will be displayed in the Network setting list on the Network 
screen.

Obtain/Specify 
DNS Information 
radio buttons

Set whether obtain a DNS server automatically or specify one 
manually.

Primary DNS field Enter the primary DNS.
Dimmed if “Obtain DNS Information Automatically” is selected.

Secondary DNS 
field

Enter the secondary DNS.
Dimmed if “Obtain DNS Information Automatically” is selected.

Connection Name 
field

Connection setting 
information list

Register button

Network screen
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Creating a new LAN setting
1. On the Internet Setting Wizard screen, tap the “LAN-TCP/IP”.
2. Tap “Next”.

Fill out the following screens.
If necessary, tap “Back” on the following screens to modify settings on the 
previous screen.
Enter the IP address information and then tap “Next”.

3. Enter your username and password for receiving e-mails and then tap “Next”.
Tapping “Next” without entering the username will go to step 6.

Obtain/Specify IP 
address radio buttons

Select whether the IP address will be automatically 
obtained or specified manually.

IP Address field Enter the IP Address, if necessary.
Dimmed if “Obtain IP address Automatically” is selected.

Subnet mask field Enter the subnet mask, if necessary.
Dimmed if “Obtain IP address Automatically” is selected.

Gateway field Enter the Gateway address, if necessary.
Dimmed if “Obtain IP address Automatically” is selected.

Obtain/Specify IP 
address radio buttons

IP Address field
Subnet mask field
Gateway field

Username field
Password field
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4. Enter the server information for sending/receiving e-mails and then tap “Next”.

5. Enter the name of e-mail sender and e-mail address and then tap “Next”.

6. Enter the DNS server information and then tap “Next”.

Incoming mail 
(POP3) field
Outgoing mail 
(SMTP) field

Email sender field

Email address field

Obtain/Specify DNS 
Information radio 
buttons

Primary DNS field
Secondary DNS field
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7. Set the connection name and confirm the contents of the setting.

8. Press the OK key or tap “Register”.
A confirmation screen will be displayed.

9. Press the OK key or tap “Complete”.
The created settings will be displayed in the Network setting list on the Network 
screen.

Obtain/Specify 
DNS Information 
radio buttons

Set whether obtain a DNS server automatically or specify one 
manually.

Primary DNS field Enter the primary DNS.
Dimmed if “Obtain DNS Information Automatically” is selected.

Secondary DNS 
field

Enter the secondary DNS.
Dimmed if “Obtain DNS Information Automatically” is selected.

Connection name 
field

Connection setting 
information list

Register button

Network screen
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Creating a new wireless LAN setting
Both the SL-6000L (with internal wireless LAN module) and the SL-6000N have the 
same setting procedures.

1. On the Internet Setting Wizard screen, tap the “Wireless LAN-TCP/IP”.
2. Tap “Next”.

Fill out the following screens.
If necessary, tap “Back” on the following screens to modify settings on the 
previous screen.
Enter the ESS-ID and then tap “Next”.

3. Select whether the WEP key is set for the wireless network and then tap “Next”.

ESS-ID field

Go to step 5
Go to step 4
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4. Enter the same WEP settings as the access point and then tap “Next”.

5. Enter the IP address information and then tap “Next”.

Key Type drop-down 
list button

Selects the encryption key length from the following:
40 bit (64 bit) or 104 bit (128 bit).

WEP Key Type radio 
buttons

Select the encryption key format, text or hex, and enter the 
characters as follows:
text: 5 characters for 40 bit (64 bit), or 13 characters for 

104 bit (128 bit).
hex: 10 characters for 40 bit (64 bit), or 26 characters for 

104 bit (128 bit).
The character number necessary for the WEP key is 
displayed on the left of the radio buttons.

WEP Key field Enter the encryption key set in the Key Type section.

Obtain/Specify IP 
address radio button

Select whether the IP address will be automatically 
obtained or specified manually.

IP Address field Enter the IP Address, if necessary.
Dimmed if “Obtain IP address Automatically” is selected.

Key Type drop-down 
list button

WEP Key field
WEP Key Type radio 
buttons

Obtain/Specify IP address 
radio buttons

IP Address field
Subnet mask field
Gateway field
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6. Enter your username and password for receiving e-mails and then tap “Next”.
Tapping “Next” with the username left blank will skip to Step 9.

7. Enter the server information for sending/receiving e-mails and then tap “Next”.

Subnet mask field Enter the subnet mask, if necessary.
Dimmed if “Obtain IP address Automatically” is selected.

Gateway field Enter the Gateway address, if necessary.
Dimmed if “Obtain IP address Automatically” is selected.

Username field
Password field

Incoming mail 
(POP3) field
Outgoing mail 
(SMTP) field
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8. Enter the name of e-mail sender and e-mail address and then tap “Next”.

9. Enter the DNS server information and then tap “Next”.

Obtain/Specify DNS 
Information radio 
buttons

Set whether obtain a DNS server automatically or specify 
one manually.

Primary DNS field Enter the primary DNS.
Dimmed if “Obtain DNS Information Automatically” is 
selected.

Secondary DNS field Enter the secondary DNS.
Dimmed if “Obtain DNS Information Automatically” is 
selected.

Email sender field

Email address field

Primary DNS field
Secondary DNS field

Obtain/Specify DNS 
Information radio 
buttons
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10.Set the connection name and confirm the contents of the setting.

11.Press the OK key or tap “Register”.
A confirmation screen will be displayed.

12.Press the OK key or tap “Complete”.
The created settings will be displayed in the Network setting list on the Network 
screen.
Both the SL-6000L (with internal wireless LAN module) and the SL-6000N 
connect to the network with this setting.

Note: To use the internal wireless LAN module (SL-6000L), do not attach 
another wireless LAN card to the Zaurus, as it will be used instead of the 
internal LAN module.

Network screen
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Creating a new setting without using the 
Wizard

The Wizard screen allows you to complete necessary network settings including 
EMail settings, such as e-mail addresses and mail server.
Without the Wizard screen, you can only make settings for Internet connections. The 
EMail settings will be made in the EMail application.

Creating a new LAN/Wireless LAN setting
Both the SL-6000L (with internal wireless LAN module) and the SL-6000N have the 
same procedures for the “Wireless LAN” setting.

1. On the Network screen, tap the Connection type drop-down list button and then 
tap “LAN” or “Wireless LAN”.

2. Tap “Add”.
When the LAN is selected, the LAN screen will be displayed consisting of four 
tabs: Account, TCP/IP, DNS, and Proxy.
When the Wireless LAN is selected, the Wireless LAN screen will be displayed 
consisting of six tabs: Account, Config, WEP, TCP/IP, DNS, and Proxy.

3. Enter the desired name for this connection in the Name field on the Account 
screen.
This name is displayed when you tap the Connection Status icon on the taskbar.
For Wireless LAN settings, go to the next step, or for LAN settings, skip to 
step 6.

Name field

LAN Wireless LAN
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4. For the Wireless LAN settings, tap the “Config” tab and set the ESS-ID. 

5. For the Wireless LAN settings, tap the “WEP” tab to set the encryption key.
The encryption key (WEP) is used for data security for wireless communications. 
Enter the same settings as the access point.

ESS-ID checkbox Clear to specify the ESS-ID.
ESS-ID field Enter the ESS-ID when ESS-ID checkbox is cleared.
Network Type 
drop-down list button

Select “Infrastructure” (for connection via wireless LAN 
access point) or “802.11 Ad-Hoc” (for ad-hoc 
connection) when “ESS-ID checkbox” is cleared.

Channel spinbox Select the desired channel for the Ad-Hoc network 
connection. This setting cannot be used if 
"Infrastructure" is selected for the Network Type.

ESS-ID checkbox
ESS-ID field
Network Type 
drop-down list button

Channel spinbox

Key Type 
drop-down list button

WEP Key field
WEP Key Type 
radio buttons

Authentication 
drop-down list button

Detail button
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If necessary, tap “Detail” to enter the WEP keys.

On the Detail screen, enter the WEP keys and tap the radio button of the 
selected WEP key and then tap . The Detail screen returns to the previous 
WEP setting screen, where you can edit the selected WEP key.

Key Type 
drop-down list button

Selects the encryption key length from the following: 
Disabled, 40bit(64bit), or 104bit(128bit).

WEP key
WEP Key Type 
radio buttons

Selects the encryption key format, Text or Hex and enter 
the characters as follows:
Text: 5 characters for 40 bit (64 bit), or 

13 characters for 104 bit (128 bit).
Hex: 10 characters for 40 bit (64 bit), or 

26 characters for 104 bit (128 bit).
The character number necessary for the WEP key is 
displayed on the left of the radio buttons. 

WEP Key field Enter the encryption key set in the Key Type section.
If the Key Type is set to “Disabled”, this field is not used.

Detail button Tap to set several WEP keys according to access point 
requirements.

Authentication 
drop-down list button

Selects the way of the authentication of the access point: 
Open System or Shared Key.

Detail screen
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6. Tap the “TCP/IP” tab and set the necessary items.

7. If necessary, tap the “DNS” tab and set the necessary items. 

Obtain TCP/IP 
Information Automatically 
checkbox

When selected, the IP address is automatically 
obtained from the Dynamic Host Configuration Protocol 
(DHCP) server.

IP Address Enter the IP Address, if necessary.
Dimmed if “Obtain TCP/IP Information Automatically” is 
selected.

Subnet Mask Enter the subnet mask, if necessary.
Dimmed if “Obtain TCP/IP Information Automatically” is 
selected.

Gateway Enter the Gateway address, if necessary.
Dimmed if “Obtain TCP/IP Information Automatically” is 
selected.

Auto-detect name 
servers checkbox

When selected, the DNS information will be 
automatically assigned from the server.
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8. Tap the “Proxy” tab. 
Tap the Proxy drop-down list button and then tap the desired type.
There are two types of setting options.

No proxy

Set proxy 

Primary DNS Enter the primary DNS address, if necessary. 
Dimmed if “Auto-detect name servers” is selected. 

Secondary DNS Enter the secondary DNS address, if necessary. 
Dimmed if “Auto-detect name servers” is selected.

Default domain field Enter the default domain, if necessary.

No proxy Select when you do not set a proxy server.
Set proxy Select when you set it manually.

Host Enter the URL for a proxy server.

Proxy drop-down 
list button
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9. Tap .
The new setting will be added to the Network setting list on the Network screen.
Both the SL-6000L (with internal wireless LAN module) and the SL-6000N 
connect to the network with this setting.

Note: To use the internal wireless LAN module (SL-6000L), see page 182.

Creating a new Dial-up Modem/IrDA setting
1. On the Network screen, tap the Connection type drop-down list button and then 

tap “Dial-up”.
2. Tap “Add”.

A screen for selecting the type of connection (Modem or IrDA) will be displayed.

Port Enter the port number for a proxy server. 
Tap the up or down arrow to change the port number.

No proxy for 
checkbox

Select if you want to use a URL that does not require a 
proxy server.

No proxy for 
field

Enter the URL for which no proxy server is required. 
Dimmed if “No proxy for” is cleared.

Network type list

Select button Cancel button
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3. Tap “Dial-up (Modem)” or “Dial-up (IrDA)” and then tap “Select”.
The Dial-up Modem or IrDA setting screen will be displayed consisting of four 
tabs:
Account, Network, Modem, and Proxy.

4. Set the necessary items in the Account screen.

5. Tap the “Network” tab and set the necessary items.

Name Enter the desired name for the current connection.
Username Enter the username used to establish connection.
Password Enter the desired password used to establish connection.
Phone Enter the telephone number used to access the Internet 

Service Provider.

Auto-detect name 
servers checkbox

Select if you want to set the DNS address assigned by the 
server.

Primary DNS Enter the primary and secondary DNS by clearing the 
“Auto-detect name servers”.Secondary DNS
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6. Tap the “Modem” tab and set the necessary items. 

7. Tap the “Proxy” tab.
Tap the Proxy drop-down list button and then tap the desired type.
There are two types of setting options.

Obtain TCP/IP 
Information 
Automatically 
checkbox

When selected, the IP address is automatically obtained 
from the Dynamic Host Configuration Protocol (DHCP) 
server.

IP Address Enter the IP Address, if necessary.
Dimmed if “Obtain TCP/IP Information Automatically” is 
selected.

Subnet Mask Enter the subnet mask, if necessary.
Dimmed if “Obtain TCP/IP Information Automatically” is 
selected.

Init commands Enter if you add a special command.
Dial using 
drop-down list button

Select the dial type (Tone or Pulse).

Speed 
drop-down list button

Select the communication speed.
Choices are 9600,19200, 38400, 57600, and 115200.
The default setting (115200) is recommended unless you 
need to change it.

Hardware flow control 
checkbox

Select to perform hardware flow control (default: ON).
Leave it selected unless you need to change it.

Wait time slider Change the time-out for connection by moving the slider, 
if necessary.

No proxy Select when you do not set a proxy server.
Set proxy Select when you set it manually.

Dial using 
drop-down list button

Speed drop-down 
list button

Hardware flow control 
checkbox

Wait time slider
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No proxy

Set proxy 

8. Tap .
The new setting will be added to the Network setting list on the Network screen.

Host Enter the URL for a proxy server.
Port Enter the port number for a proxy server.

Tap the up or down arrow to change the port number.
No proxy for 
checkbox

Select if you want to use a URL that does not require a 
proxy server.

No proxy for 
field

Enter the URL for which no proxy server is required. 
Dimmed if “No proxy for” is cleared.

Proxy drop-down 
list button
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Setting Automatic Connection

You can set the Zaurus to automatically connect to the network using the access 
point for the communication card (modem or LAN) inserted into the card slot. 
Automatic connection will be executed when you tap  on the taskbar, or send and 
receive e-mail messages (see page 98).

Note: When you set automatic connection, the Zaurus tries to connect 
automatically 5 seconds later.

For Dial-up / LAN
With the following setting, the Zaurus will automatically connect to the access point 
checked on the Network setting list when a modem card or LAN card is inserted and 
you perform a connection operation (see page 196).

1. On the Network screen, tap the Connection type drop-down list button and then 
tap “Dial-up” or “LAN”.

2. Tap the checkbox for the access point you select most often.
You can select one checkbox for Dial-up and for LAN respectively. 

3. Select “Auto-connect” and “Show confirmation screen”.
The automatic connection will be set.

Note:

• To connect to the access point for unchecked service, select the access point 
from the list displayed on the confirmation screen after the connection 
operation (see page 197).

• If you clear “Auto-connect”, the Zaurus does not automatically connect. In this 
case, select the access point on the screen displayed after you perform the 
connection operation, then tap “Connect”.

• If you clear “Show confirmation screen”, the confirmation screen (see page 
197) for automatic connection does not appear.

Select the access point for 
automatic connection 
checkbox

Network setting list

Auto-connect checkbox
Show confirmation 
screen checkbox

Connection type 
drop-down list button

Connect button
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For Wireless LAN
With the following setting, the Zaurus will automatically connect to the available 
access point when you perform a connection operation (SL-6000L), or perform a 
connection operation and insert a wireless LAN card (SL-6000N). The access point 
will automatically be chosen by priority, from the selected access points.

1. On the Network screen, tap the Connection type drop-down list button and then 
tap “Wireless LAN”.

2. Tap the checkbox for the access point you select most often.
You can select several checkboxes for wireless LAN connection.

3. Tap a setting with ESS-ID and tap  or  to change the priority order.
The list is in priority order.

4. Select “Auto-connect” and “Show confirmation screen”.
The automatic connection will be set.

Note:

• If you clear “Auto-connect”, the Zaurus does not automatically connect. In this 
case, select the access point displayed on the screen after you perform the 
connection operation, then tap “Connect”.

• If you clear “Auto-connect”, the confirmation screen (see page 197) for 
automatic connection does not appear.

Show confirmation
screen checkbox

Auto-connect checkbox

Connection type 
drop-down list button

Connect button

Change order button

Select the access point for 
automatic connection 
checkbox

Network setting list
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Modifying/Deleting the network setting

The network service settings that you have set up are listed and handled on the 
Network screen. On this screen, you can change the settings that have been created 
and create a new setting by using a duplicate of the selected setting.

Confirming settings
1. On the Settings Home screen, tap the “Network” application icon.

The Network screen will be displayed.
2. Tap the Connection type drop-down list button and then tap the setting you want 

to confirm.

Connection type 
drop-down list button

Network services will 
appear by the 
Connection type 
drop-down list button.
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Modifying settings
1. On the Network screen, tap the Connection type drop-down list button and then 

tap the setting you want to modify.
2. Tap “Edit”.
3. Modify the setting and save the modifications.

For details on how to edit and save the modifications, see the procedures of 
each new creation on pages 169-190.

Duplicating the setting
For settings similar to connection settings that already exist, it is more efficient to 
duplicate the settings.

1. On the Network screen, tap the Connection type drop-down list button and then 
tap the setting you want to duplicate.

2. Tap the “Edit” menu and then tap “Duplicate”.
The contents of the settings are automatically duplicated and an edit screen will 
be displayed.

3. Edit only the necessary items and save under a different name.
For details on how to edit and save the modifications, see the procedures of 
each new creation on pages 169-190.
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Deleting settings
1. On the Network screen, tap the Connection type drop-down list button and then 

tap the setting you want to delete.
2. Tap “Delete”.

A confirmation message will be displayed.
3. Tap “Yes”.

The selected setting will be deleted.

Exporting/Importing a network setting

You can export and save a network setting as a setting file in the Internal flash 
memory or memory cards. You can also import a setting file and add it to the setting 
list.

Exporting a setting file
1. On the Network screen, tap the setting in the setting list you want to export.
2. Tap the “Edit” menu and then tap “Export”.

The Export Settings screen for entering an export file name and selecting 
destination to save will be displayed.

3. Select the desired folder to save an export file and enter a file name in the File 
Name field.

4. Tap  on the Export Settings screen.
A confirmation screen will be displayed.

5. Tap “OK”.
The exported file of the selected setting is saved in the folder.
The screen returns to the Network screen.
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Importing a setting
1. On the Network screen, tap the “Edit” menu and then tap “Import”.

The Import Settings screen for selecting an import file will be displayed.

2. Select the setting file to import, and then tap .
A confirmation screen will be displayed.

3. Tap “Yes”.
A confirmation screen will be displayed.

4. Tap “OK”.
The screen returns to the Network screen.
The imported setting is added to the setting list.

Connecting to/disconnecting from the Network

Be sure that you have completed your settings following the procedure of “Network 
Settings (Network)” on page 167.

Connecting to the Network
1. Insert the communication card into the Card slot.

The Connection Status icon (disconnected ) will be displayed on the taskbar.

Note: Be sure to insert the card with the Zaurus turned on. 
When ejecting the card, tap the CF(SD) card icon on the taskbar and 
select “Eject CF card” or “Eject SD-card”.
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2. Tap the Connection Status icon ( ) on the taskbar.
Or tap the Qt Menu icon ( ) on the taskbar and then tap “Connect”.
The following confirmation screen for network connection will be displayed, and 
connection is performed automatically 5 seconds later (in accordance with the 
settings for automatic connection, described on page 191).

• If you do not want to wait for 5 seconds, tap “Connect” to connect 
immediately.

• If you want to specify an access point even though the automatic setting is set, 
select the access point from the list displayed before connecting (within 5 
seconds), and then tap “Connect”.

• If you clear “Auto-connect” on the Network screen, select the desired access 
point on this confirmation screen and then tap “Connect”.

• For connection without this confirmation screen, check the “Do not show this 
window after this” on the confirmation screen. It will not appear even if you 
clear the “Show confirmation screen” checkbox on the Network screen.

• If authentication is necessary, a password entry screen will be displayed after 
the confirmation screen. Enter your password then press the OK key.

If connection to the network is established, the Connection Status icon ( ) 
turns to .
During wireless communication, the Connection Status icon displays signal 
strength level.
Blue: Excellent, Green: Good, Yellow: Average, Red: Poor.

Note: If connection is not carried out, make sure that the Network settings are 
correct and refer to the online manual, “Troubleshooting Guide”.

Wireless LANDial-up/LAN
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Attaching two connectable devices to the 
network

For example, if you attach a Modem Card to the SL-6000L, there will be two different 
devices, the Modem Card and an internal wireless LAN module, connected to the 
network.
In this case, perform network settings for both devices. If Automatic Connection is 
set (see pages 191 and 192), perform the following operations.

1. Tap the Connection Status icon (  or ).
2. The screen to select which network device to connect is displayed.

3. Select the setting and then tap “Connect”.
4. The network connection confirmation screen (see page 197) is displayed, and 

the device connects to the network.
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Disconnecting from the Network
1. Tap the Connection Status icon (  or ) and then tap “Disconnect” on the 

pop-up screen. Or tap the Qt Menu icon ( ) on the taskbar and then tap 
“Disconnect” in the pop-up screen.
If the connection to the network is disconnected, the Connection Status icon (  
or ) returns to .

Note: While connection is established, “Connect” turns to “Disconnect” on the 
pop-up screen for network connection.


	Introduction
	About this manual

	Address Book
	Overview
	Creating a new Address Book entry
	Attaching a Note
	Modifying an Address Book entry
	Duplicating an Address Book entry
	Deleting an Address Book entry
	Arranging the entry fields
	Arranging the display items on the Index screen
	Changing the sort order of the entry
	Registering/Editing your personal information (Owner Information)

	Calendar
	Overview
	Displaying Todo task entries
	Viewing the link files
	Selecting the link option for the memory card
	Changing the date to link files
	Adding an Event entry
	Modifying an Event entry
	Duplicating an Event entry
	Deleting an Event entry
	Calendar Setup

	Todo List
	Overview
	Creating a new Task entry
	Modifying a Todo task entry
	Duplicating a Todo task entry
	Deleting a Todo task entry
	Checking a completed entry on the Index screen

	Imaging
	Overview
	Writing memos by hand (creating new memos)
	Modifying a memo (image file)
	Deleting a memo (image file)
	Changing filenames
	Rotating the image 90 degrees and saving it
	Viewing a single image
	Displaying a slideshow of the files
	Changing Image view screen, the Cancel key actions, and slideshow settings
	Switching the view mode on the Index Screen

	Text Editor
	Overview
	Creating a new text file (Text Index screen)
	Creating a new note entry (Notes Index screen)
	Modifying a text file/note entry
	Deleting a text file/note entry
	Duplicating a text file to/from a note entry
	Setting the wrap lines
	Renaming a text file
	Defining the Cancel key function for the Text Index screen
	Selecting the character code for opening or saving files

	Media Player
	Overview
	Playing a file
	Playing a file in the Playlist
	Other functions

	Opera Browser
	Overview
	Opening the specified Web page
	Using the Web Search function
	Using bookmarks
	Creating a new folder in the bookmark list
	Saving the current page and viewing it offline
	Managing the window
	Magnifying or reducing the page
	Switching the Screen layout
	Searching for a word or phrase on the current page
	Setting the Opera Browser
	Keyboard shortcuts

	EMail
	Overview
	E-mail accounts
	Creating an e-mail message
	Sending e-mail messages in the Outbox
	Receiving e-mail messages
	Opening an e-mail message
	Opening or arranging attachments
	Replying/Forwarding to an e-mail message
	Editing an e-mail message
	Deleting e-mail messages
	Registering the e-mail address of the sender in the Address Book application
	Changing the view pattern
	Other settings
	Preventing disconnection from the network after transferring e-mail messages (if automatic connec...
	Setting the attachment file option
	Changing the action of the Send mail icon and Get mail icon on the Index screen
	Creating a new folder and organizing e-mail messages
	Filtering received e-mail messages
	Searching for received e-mail messages
	Moving or duplicating e-mails between the Internal Flash and memory cards

	Voice Recorder
	Overview
	Recording
	Playing
	Renaming a recorded file
	Deleting a recorded file
	Setting the preferences

	Tools
	City Time
	Clock
	Calculator
	Help Browser

	Settings
	Add/Remove Software
	Setting the Appearance (Appearance)
	Using the Application Key (Application Key)
	Backup Restore (Using memory card)
	Beam Receive
	Adjusting the date and time (Date/Time)
	Power Management (Light & Power)
	Adjusting the touch panel (Recalibrate)
	Setting security (Security)
	Sound Settings
	System Info
	Tab Setting
	PC Link

	Network Settings (Network)
	Overview
	Creating settings using the Wizard screen
	Creating a new setting without using the Wizard
	Setting Automatic Connection
	Modifying/Deleting the network setting
	Exporting/Importing a network setting
	Connecting to/disconnecting from the Network
	Attaching two connectable devices to the network


